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Under the copyright laws, this manual may not be reproduced in any form without the prior written consent of Cooper 
Notification, Inc. No patent liability is assumed with respect to the use of the information contained herein.

Any use of WAVES Software is subject to and conditioned upon [your] acceptance of the Cooper Notification, Inc. 
software licensing agreement.

TRADEMARKS
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Secure, Inc. dba Cooper Notification protected by U.S. patent 7,409,428; other patents pending. HPSA, SPT, and 
LMD are trademarks of Cooper Notification, Inc. in the U.S.A. and other countries. Windows is a registered 
trademark of Microsoft, Inc. Other brands and their products are trademarks or registered trademarks of their 
respective holders and should be noted as such.

EXPORT
This document contains technical data that may be controlled under the U.S. Export Administration Regulations and 
may be subject to the approval of the U.S. Department of Commerce prior to export. Any export, directly or 
indirectly, in contravention of the U.S. Export Administration Regulation is prohibited.

DISCLAIMER
This manual has been reviewed for accuracy when used in conjunction with Cooper Notification authorized 
administrator and/or operator training. The information contained herein was accurate for the software at the time of 
this manual's production. Cooper Notification assumes no liability for damages incurred directly or indirectly from 
errors, omissions, or discrepancies between WAVES and the manual.
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DISCLAIMER - NCT WHEN USED WITH TRX OR CRLU
Changes or modifications that are not expressly approved by Cooper Notification could void the user’s right to 
operate the equipment.

This device complies with Part 15 of the Federal Communications Commission (FCC) Rules. Operation is subject to 
the following two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may cause undesired 
operation.

The following table (Table FR.1) contains a list of the approved antennae for use with a TRX or CRLU. Antenna 
installation is limited to those listed in Table FR.1 and may only be installed by a professional. 

TABLE FR.1   Antennae Approved for Use

Description Cooper P/N Manufacturer
Manufacturer Part 
Number

Antenna, 9DBI, Omnidirectional A01-02255 Mobile Mark OD9-2400

Antenna, Omni-directional, 15 
DBI

A01-02257 Hyperlink Technologies HG2415U-PRO

Antenna, Directional, 8DBI A01-02259 Hyperlink Technologies RE09P-NM

Antenna, Omnidirectional, 3DBI A01-02260 Hyperlink Technologies HG2403RD-NM

Antenna, Omni, 6DBI A01-02820 Maxrad MFB24006

Antenna, 2.4GHZ 15DBI, 
GRID, N-FEM CON

A01-02856 Hyperlink Technologies HG2415G-NF

Antenna, 2.4 GHZ, 13.9 DBI, 
YAGI

A01-02859 Laird Technologies PC2415N

Antenna, 2.4GHZ, 15DBI, 
YAGI, N-FEMALE

A01-02860 Hyperlink Technologies HG2415Y-NF

Antenna, Fixed, 15DBI A03-02416 Hyperlink Technologies HG2416P
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SAFETY SUMMARY
Safety Notices, Warnings, and Cautions must be applied during operation and maintenance of the equipment. If 
situations arise that are not covered in the General Safety Notices, Warnings, or Cautions the local authority will issue 
instructions as deemed necessary to resolve the situation.

GENERAL SAFETY NOTICES
The following safety notices supplement the specific Warnings and Cautions found throughout this manual. 

• Equipment must be clear of all power lines, wires, and electrical obstructions at all times.

• Ensure that precautionary measures are employed to prevent applying power to equipment at any time 
maintenance work is in progress.

• Do not touch electronic components with wet hands.

• Do not make any unauthorized alterations to equipment or components.

• Do not wear loose clothing while working around rotating parts of machinery.

• When working near electricity do not use metal rules, flashlights, metallic pencils, or any other object 
having exposed conducting material.

• When possible, avoid installing equipment during severe or wet conditions. Handling equipment with wet 
hands may cause slippage resulting in bodily injury and/or damage to equipment.

• Ensure the area is well ventilated when using cleaning, gasoline, and oil products. Avoid prolonged 
breathing of fumes which may cause physical harm.

• Proper personal protective equipment (PPE) should be used when changing a battery. This equipment 
includes acid resistant gloves, and safety glasses, as well as proper body acid-resistance coverings and safety 
shoes.

OPERATING RESPONSIBILITIES
It is the responsibility of the owner and/or operator of the product to ensure the following.

• The equipment is correctly and safely installed.

• When installed, the equipment fully complies with federal, state, and local codes.

• Any person operating this equipment has been properly trained.

• Any person who has not been trained on the safe use of this equipment does not have access to it.

C

Circuit boards are electrostatic sensitive. All Electrostatic Discharge (ESD) sensitive components contain solid 
state circuits that may become damaged when contacted with an electrostatic charge. Extreme care must be taken 
to protect the circuitry. 

Wear a static dissipating grounding wrist strap or similar protective device grounded at the nearest available bare 
metal chassis or other ground point BEFORE touching the circuit board. 

Always hold a components board by its edges or facing plate if available. Avoid touching the edge connectors. 
Never slide components over any surface.

Failure to follow correct grounding procedures may cause severe damage to the circuitry.
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• Any person operating this equipment has access to all documentation and information required for the safe 
use and operation of this equipment.

• Any person operating this equipment remains alert at all times. Never operate machinery when physically or 
mentally fatigued, or while under the influence of alcohol, drugs, or medication.

• The equipment is properly maintained and safety inspected at regularly scheduled intervals.

WARNINGS
Specific warnings used in this manual are summarized below and pages referenced. These warnings appear 
throughout the manual.

• Make sure electrical connections are secure before applying power to a unit. Failure to secure connection 
may cause an electrical arc resulting in physical shock or damage to equipment. (Page 74)

CAUTIONS
Specific cautions used in this manual are summarized below and pages referenced. These cautions appear throughout 
the manual.

• (None cited.)
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MODIFICATION RECORD

The following table displays the modifications made to this manual.

TABLE FR.2    Manual Modification Record

MOD # ECN # Description

A N/A Original

B 90132 Front Matter: Updated General Safety Notices and added “Operating Responsibilities” 
section to stay consistent with manual template style.

Preface: Changed “Customer Support” to “Customer Satisfaction” and corrected the phone 
number.

Section 4.1.1: Added two new notes (one after the second paragraph and one at the end of 
the section).

Sections 4.1.1.1, 4.2.1.1, and 4.2.1.2: Changed reference to section in “WAVES 
Administrator Manual” from “Audio Settings” to “WAVES Volume Settings”.

Section 4.2.4.4: Rewrote end of first paragraph; rewrote step 1; rewrote paragraph before 
Table 4.3.

Section 4.2.4.4: Edited Table 4.3 in the following rows - Battery row, RSSI row, Miss 
Correlations row, deleted Link Enable row, Audio CRC fail row, Speaker Tower Status row, 
ACU Status row.

C 100026 Front Matter: Added disclaimer pertaining to FCC rules and the NCT manual; Added list of 
approved antennae for TRX and CRLU.
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Preface
This manual provides a user with the information needed to install, configure, and operate 
the WAVES system. To better understand WAVES functionalities and features, a system 
overview is also provided.

An outline of each chapter’s content is briefly described in the section below, as well as a 
list of terms and conventions used in this manual and customer support information. 

About This Manual
To assist you in quickly identifying each chapter’s content, a brief chapter description is 
provided below.

Chapter 1, “Introduction”

This chapter presents the WAVES system and its capabilities, main features, components, 
and principle of operation.

Chapter 2, “Using the Network Configuration Tool”

This chapter familiarizes the user with the Configuration Tool screen and its menus and 
toolbars.

Chapter 3, “Creating a Functional Site Tree”

This chapter describes how to build a functional site tree of elements in the WAVES 
network. 

Chapter 4, “Configuring Site Tree Elements”

This chapter describes how to define zone, sub-zone, and unit properties for each 
element’s on the site tree. 

Chapter 5, “Setting Up Peripheral Devices”

This chapter describes procedures for configuring the peripheral devices in the WAVES 
network.

Appendix A, “TRX Transmitting Offset Assignments”

This appendix provides recommended transmitting offset assignment numbers for RF 
frequency values.
WAVES Network Configuration Tool Administrator Manual v5.6.1 xv
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Appendix B, “TRX Firmware Update Procedures”

This appendix provides instructions for updating or reloading transceiver firmware.

Appendix C, “Configuring the RF AGC Setting”

This appendix describes how to change the AGC setting by writing a custom command 
and sending it to a TRX.

Appendix D, “Troubleshooting”

This appendix provides a list of problems and resolutions for problems that may occur 
when using the Network Configuration Tool.

Documentation Conventions
The following tables describe frequently used terms and icon conventions found in this 
manual. For definitions of additional words and acronyms used in this manual, see the 
Glossary on page 81.

TABLE PR.1 Documentation Terms

Term Description

Base Station The command center of the WAVES network.

The term is used interchangeably with “IBS.”

Configuration Tool Part of the WAVES application that allows administrators to 
configure and define global and individual transceiver settings for 
devices in the WAVES system. 

The term is used interchangeably with “Network Configuration 
Tool” and “NCT.”

Device An appliance attached to a transceiver that provides input or sends 
messages into the WAVES system. For example a chemical detector 
or wireless and fixed duress activators.

Global The entire installation site on the unit site tree.

The term is used interchangeably with “Theater” or “Site.”

IBS Integrated Base Station. The command center of the WAVES 
network.

The term is used interchangeably with “Base Station.”

NCT Part of the WAVES application that allows administrators to 
configure and define global and individual transceiver settings for 
devices in the WAVES system. 

The term is used interchangeably with “Configuration Tool” and 
“Network Configuration Tool.”

Network Configuration 
Tool

Part of the WAVES application that allows administrators to 
configure and define global and individual “transceiver settings for 
devices in the WAVES system. 

The term is used interchangeably with “Configuration Tool” and 
“NCT.”
xvi WAVES Network Configuration Tool Administrator Manual v5.6.1
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Site (Site-wide) The entire installation site on the unit site tree. 

The term is used interchangeably with “Theater” and “Global.”

Theater The entire installation site on the unit site tree. 

The term is used interchangeably with “Global” and “Site.”

Transceiver An addressable node in the WAVES wireless network that receives 
and broadcasts messages, such as the TRX-401, CRLU-201, VHF 
Radio 400, and UHF Radio 500.

he term is used interchangeably with “Unit”, “TRX”, or “CRLU.”

TRX An addressable transceiver node in the WAVES wireless network 
that uses FHSS technology to broadcast RF signals over a wide range 
of frequencies.

The term is used interchangeably with “Transceiver” and “Unit.”

Unit An addressable node on the site tree that represents an individual 
transceiver in the WAVES network.

The term is used interchangeably with 'Transceiver' or “TRX.”

TABLE PR.2 Icon Conventions

Icon Description

Users should not disregard information in a Note. Indicates information that 
emphasizes or supplements important points of the main text which, in some cases, 
may be essential to the completion of a task. A Note is typed in regular lower case 
text.

ALERTS THE USER TO POSSIBLE HAZARDS WHICH MAY CAUSE 
LOSS OF LIFE, PHYSICAL INJURY OR ILL HEALTH IN ANY FORM 
EITHER IMMEDIATE OR LATENT. A WARNING NOTE IS TYPED IN 
BOLD UPPER CASE TEXT.

Alerts the user to possible hazards which may cause damage to 
equipment but not danger to people. A Caution note is typed in bold 
lower case text.

TABLE PR.1 Documentation Terms

Term Description
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Getting Help
For assistance, comments, or inquiries please contact Customer Satisfaction at the 
following:

Cooper Notification
7565 Commerce Court
Sarasota, Florida 34243
U.S.A.
Telephone:941.487.2379
Fax:941.487.2389
Email:mvsr-support@cooperindustries.com
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CHAPTER 1

Introduction
The Wireless Audio Visual Emergency System (WAVES) is an integrated alerting and site 
protection system. It provides control of live and recorded audio and visual warnings and 
instructions before, during, and after emergency situations to help direct everyone to 
safety. This chapter provides an overview of WAVES, its features, and components.

The following sections are included in this chapter.

• What Is WAVES?

• WAVES Features

• How Does WAVES Work?

• WAVES System Components

• Peripheral Devices

1.1 WHAT IS WAVES?
WAVES is a command and control emergency notification system that broadcasts safety 
sirens, live and recorded voice messages, and visual notifications via secure wireless 
networks to alert, warn, and inform people of what to do in an emergency or disaster. 
Using zones and subzones, people in immediate danger areas, whether indoor or outdoor, 
can be alerted quickly and accurately.

Developed using secure wireless technology, WAVES is the de-facto standard for anti-
terrorism/force protection systems used by the Federal Government. Single frequency, 
narrow band VHF/UHF communications, as well as secure digital Frequency Hopping 
Spread Spectrum (FHSS) technology and a redundancy backbone are incorporated, 
preventing jamming, interference, and eavesdropping as well as protecting the network in 
the event of a disaster. The WAVES network reconfigures automatically if a unit goes 
down, allowing alerts and messages to continue broadcasting without interruption. In the 
event the primary command center is destroyed, a fixed or mobile secondary station(s) can 
be used to control the system. To provide backup power if a grid power loss is 
experienced, each WAVES transceiver and base station are protected by an uninterruptible 
power supply (UPS). Additionally, optional solar power and backup generators can be 
added to the system, to ensure system operation during power loss.

From speaker sirens to indoor speakers and from strobes to LED signs, WAVES can send 
emergency messages in a variety of formats. An event can be programmed (scripted) to 
WAVES Network Configuration Tool Administrator Manual v5.6.1 1
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Introduction
trigger notifications without further intervention of a human operator, thereby decreasing 
response time and the likelihood of notification failures. For example, a scripted event can 
be automatically activated by an alert sensor, such as a push button at a gate, a wireless 
panic button or a Chemical, Biological, Radiological and Nuclear (CBRN) detector. 
WAVES also provides the ability to remotely access a base station and activate critical 
mass notification functions by using a telephone (including cellular) or a networked 
computer, as well as wired or wireless activators.

1.2 WAVES FEATURES
WAVES is the most reliable, field-proven secure digital wireless system available today. 
Its system features include the following:

1.2.1 Command and Control
WAVES provides the user a sophisticated command and control capability with an easy-
to-use user interface. Its PC-controllable wireless network, highly adaptable to virtually 
any type and size facility or area, can operate as a standalone system or be integrated with 
security systems such as intrusion detection, weather systems, access control, fire alarms, 
and CBRN or Nuclear, Biological, Chemical (NBC) detection systems. 

1.2.2 Simultaneous Messaging
In a WAVES network, the locally stored message feature enables simultaneous activation 
of different messages at different nodes, allowing each transceiver or HPSA at a site to 
play different messages simultaneously, while retaining the common-message alerting that 
WAVES already performs. 

1.2.3 Real-Time Emergency Alerting
WAVES integration with Cooper Notification’s Roam Secure Alert Network (RSAN™) is 
an optional feature that provides for the exchange of Common Alerting Protocol (CAP) 
messages by way of a TCP/IP network such as LAN, WAN, or the Internet. Through this 
interoperability alerts can be quickly issued to a text-enabled device, phone, fax, or 
computer.   

1.2.4 Pre-Approved Frequencies
WAVES wireless frequencies are pre-approved for use throughout military and 
government facilities (JF12 #7787 and SFAF), requiring no further action nor creating any 
delays in use.

1.2.5 Chemical, Biological, Radiological, and Nuclear Capability
WAVES has the capability to integrate with other control systems, including CBRN 
systems. Cooper Notification has worked with the US Marine Corps on integration of 
ACADA GID-3 sensor devices with WAVES and continues to work with the U.S. military 
to integrate with the most advanced CBRN sensor systems.

1.2.6 Portable Field Units
WAVES portable systems, Tactical WAVES (TACWAVES™), Mobile Speaker Tower 
(MSPT™), and Mobile Speaker Array (MSA™), can operate as standalone or be 
2 WAVES Network Configuration Tool Administrator Manual v5.6.1
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How Does WAVES Work?
integrated into one system to work as field notification units for tactical operations or 
temporary events.

1.2.7 UFC Compliant
U.S. Army Corps of Engineers identifies Cooper Notification as fully compliant with UFC 
4-021-01 Individual Building MNS. Cooper Notification is the only company that can 
supply all four types of mass notification systems as mentioned in the November 21, 2003 
ECB, which included the Individual Building, Giant Voice, Telephone Alerting, and 
Installation-Wide Control System. 

1.2.8 J-34 Department of Defense Anti-Terrorism Directorate
WAVES is the only wireless alerting system that meets all J-34 Department of Defense 
Anti-Terrorism Directorate requirements. In 1998 the Joint Chiefs of Staff established 11 
requirements that any Personnel Alerting System (PAS) system must meet. U.S. Army 
CECOM tested available PAS systems and found that WAVES was the only system that 
fulfilled all 11 requirements.

1.3 HOW DOES WAVES WORK?
The WAVES system consists of a base station and up to 15,376 uniquely addressable field 
transceivers that create a radio frequency (RF) network of many transceivers connected 
together. Each transceiver has a single transmitter that it listens to and may have none, 
one, or multiple transceivers that it transmits to. The base station transceiver is the highest 
level transmitter that all other transceivers listen to, either directly or through other 
transceivers. All digital traffic flows from the base station transceiver in the forward 
channel and flows back through the backwards channel. 

The RF network is controlled by firmware inside each transceiver. When a transceiver is 
powered up it searches for a transmitter to listen to. Upon locating a valid transmitter that 
has sufficient signal strength, the transceiver locks-on to the transmitter. Any loss of signal 
from the transmitter causes the transceiver to search for another transmitter in its table of 
valid transmitters. Once locked-in, communication can take place between nodes in the 
WAVES system. 

In addition to the hardware RF path, each transceiver listens and reports to the base station 
computer’s WAVES software. A logical address is assigned to each transceiver, based 
upon its location in an installation site tree. All commands to and from the transceiver 
reference its address. For any on-line element information to be received by the WAVES 
software and reflected the database, the correct address must be programmed into the 
transceiver. This is automatically done when you program the various properties of each 
transceiver. Once the transceivers are configured and the system is setup, an operator 
stationed at a WAVES console can monitor the system and initiate responses to 
notifications. 

1.4 WAVES SYSTEM COMPONENTS
• Integrated Base Station (IBS)

− Base Station Transceivers

− Audio Data Unit (ADU-301)
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Introduction
− Central Command Unit (Personal Computer)

• Field Transceivers

1.4.1 Integrated Base Station (IBS)
The IBS is the command center of the WAVES 
network. All sensor appliances, like Wireless 
Activator (WA) panic buttons and Nuclear, Biological, 
and Chemical (NBC) detectors send their signals 
through the RF network to the IBS, which is running 
WAVES software. The software is set up during 
installation to either immediately respond and alert 
personnel to safety through notification appliances, 
such as speakers, strobes, and LED text signs, or to 
allow the operator at the IBS to decide what action to 
take.

In addition to optional peripheral devices the IBS 
system includes a UPS, Primary/Alternate Base 
Station Switch, microphone, cables, antennas, and a 
built-in speaker. The core IBS components are 
described in the sections that follow.

FIGURE 1.1 Integrated Base Station

1.4.1.1 Base Station Transceivers

A base station transceiver facilitates communication between a WAVES IBS and field 
transceiver nodes. The IBS can contain one or both of the following base station 
transceivers: a CRLU-201 for TRX communication, and/or a Radio-400 (VHF)/Radio-
500 (UHF) transceiver.

1.4.1.1.1 CRLU-201

The CRLU-201 is the base station transceiver unit of the WAVES system for TRX FHSS 
communication. It transmits multiple channels of audio and visual display messages, as 
well as RS-232 data and control information for wireless distribution within the WAVES 
system. At the same time, it receives RS-232 data and network-wide supervisory Built-in 
Test (BIT) diagnostic reports for subsequent transmission to the WAVES software.

FIGURE 1.2 CRLU-201

The CRLU-201 is a fully integrated unit with an integral power supply, audio amplifiers, 
and antennas. It digitizes incoming analog audio streams from an ADU-301 and 
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WAVES System Components
communicates with the ADU-301 through a multi-pair, shielded cable terminated in a 
DB-25 connector. RS-232 data is communicated through a DB-9 connector. The CRLU 
can also be programmed to function as a TRX field transceiver. 

The CRLU is powered locally from either an AC (100-240V, 47-63Hz) or DC (12-16V) 
power source, or remotely from the ADU-301 through a designed cable. The device can 
also accommodate an optional UPS-901 that can provide up to five hours of operation. 
The UPS-901 batteries are stackable, allowing for extended backup time.

The CRLU-201 can be configured to function as a Satellite Relay Unit (SRLU) and a 
Backup CRLU to create an Alternate Base Station.

1.4.1.1.1.1 CRLU-201 SRLU Configuration

The SRLU is used as a relay with the added capability of being an independent audio 
source for local announcements, or when more than two audio sources are needed.

The following diagram is an example of an application with a SRLU.

FIGURE 1.3 Example of an application with SRLU

1.4.1.1.1.2 SRLU Audio/Voice Switching Priorities

The SRLU audio channels can be configured to broadcast one of two audio sources: Local 
or Base. In Local mode, the local audio inputs (the output from the local ADU) are 
transmitted to the SRLU zone. In Base mode, only the audio channels received from the 
CRLU are transmitted to the SRLU zone.

The SRLU voice channels are configured to establish the relative priority of the PTT 
messages received from the local ADU and the CRLU. In Base mode, a PTT message 

All CRLU-201 and UPS-901 circuits have a Class 2 rating.

You can address the following functions to the CRLU: PTT, volume, discrete 
I/O and audio messages. You cannot address visual messages to the CRLU.
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Introduction
from the CRLU will override a PTT from the local ADU. In Local mode, PTT from the 
local ADU will override a PTT message from the CRLU. 

See the “Audio Files” section in the WAVES Administrator Manual for instructions on 
setting the SRLU audio and voice configurations.

1.4.1.1.1.3 Backup CRLU-201 Configuration (Alternate Base Station)

As an Alternate Base Station, the CRLU-201functions as an SRLU until activated by 
turning the Primary/Alternate Base Station switch on the front of the IBS. When the 
switch is in Primary position, the unit acts as an SRLU. When the switch is Alternate 
position, the unit becomes the network CRLU.

FIGURE 1.4 Example of site with Backup CRLU

All functions of the SRLU, as described in Section 1.4.1.1.1.1, “CRLU-201 SRLU 
Configuration”, apply to the Backup CRLU configuration. 

1.4.1.1.2 Radio-400 and Radio-500 (Base)

The base station Radio-400 (VHF) or 500 (UHF) are transceivers used to facilitate 
communication between an IBS and VHF/UHF-radio-equipped nodes. For WAVES 
systems using VHF/UHF radio nodes, the IBS contains a Master COTS radio controller 
that communicates through a Master COTS VHF/UHF radio with a network of VHF/UHF 
radio-enabled nodes in the WAVES network. As with the CRLU, the VHF/UHF radio 
transmits audio messages and control information for distribution within the WAVES 
system. The radio also processes supervisory diagnostic reports.
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FIGURE 1.5 Radio-400 VHF base station transceiver

1.4.1.2 ADU-301

The ADU-301 is the interface between the IBS personal computer (PC) and the base 
station transceiver, providing an interface between its input audio and data channels and 
the base station transceiver. It converts data from the PC to a form usable to the transceiver 
and provides the interface. The base station transceiver subsequently communicates with 
the field transceivers.

FIGURE 1.6 ADU-301 front and rear panels

The following connections can be made by way of the ports on the ADU-301.

• Two balanced or unbalanced line-level audio sources (ChA and ChB) can be 
connected via the XLR connector on the front panel or the ¼-inch phono jacks on 
the rear panel. Each channel level can be adjusted using the -20 dB pad, the 
+30 dB trimmer and the peak/clip LED indicators (on the front and rear panels). 

• A PC sound card can be connected (TO/FROM) via stereo phono jacks provided 
on the rear panel.

• A microphone can be connected via the XLR connector on the front panel or the 
¼-inch phono jack on the front panel. The microphone input includes a pre-
amplifier and soft-limiter compressor. The microphone can be activated via the 
front panel PTT switch or from an external control signal connected to a ¼-inch 
phono jack.

• A monitor stereo speaker/headphone output with adjustable gain up to 4 watts per 
channel is provided via a ¼-inch phono jack on the front panel (Tip – Channel A + 
Voice and Ring – Channel B + Voice).

• A bridge can be set up between a data device and the CRLU-201 RS-232 
connector via the ADU-301 DATA Ports: RS-232 TO CRLU and RS-232 
connectors.

• RS-232 to RS-422 conversion can be made through an interface between the 
optional PC (RS-232 via its DATA PORTS: TO PC CONTROL connector) and 
the CRLU-201 (RS-422 via its DATA PORTS: To CRLU connector).

• Power is provided locally from an AC (100-240V, 47-63Hz) power source. It can 
also provide power to, or receive power from the CRLU-201 through the CAB-
ADU-25-CRLU-4 cable.
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The ADU voice output depends on one of the two voice inputs and on the following 
priorities:

• Top Priority – Microphone + PTT. When pressing the PTT button, the 
microphone is enabled, and any other voice signal is disabled.

• Second Priority – Sound card. When activating a message through the computer 
(by the Scheduler or audio/visual message), the audio output is transmitted.

1.4.1.3 IBS Personal Computer
The IBS contains a custom personal computer that is the heart of the system and controls 
the network through the WAVES software application. The network database, all 
messages, and scheduled events are stored in and controlled from the PC.

Using the WAVES software, transceivers can be monitored from the base station and 
grouped into zones and sub-zones to facilitate real-time control of audio, voice and data 
messages, prerecorded and saved messages, and scheduled message broadcasts. 

1.4.2 Field Transceivers
Field transceivers are addressable nodes in the wireless network that receive and broadcast 
messages sent to them. The transceivers can independently process information 
selectively transmitted to them from the base station or from local sensors. They then 
amplify audio signals for speakers and send data to visual display signs and other 
connected output appliances. This enables WAVES installers to adapt each transceiver to 
its immediate acoustic environment and the WAVES operators to adapt each transceiver to 
changing conditions. In this way, acoustic quality and transceiver integrity can be 
maintained. 

1.4.2.1 TRX-401

The TRX-401 is an addressable transceiver node in the WAVES network that uses FHSS 
technology to broadcast RF signals over a wide range of frequencies. Frequency offsets 
are used to spread RF signals. Receiving stations use their frequency offset settings to 
recognize and retrieve RF signals directed to them. Each transmitter receiver pair hops in 
synchronization across 76 channels in a pseudo-random pattern. Spreading the frequency 
like this makes the signal hard to interfere with and hard to eavesdrop into.

All ADU-301 circuits have a Class 2 rating.
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Peripheral Devices
 

FIGURE 1.7 TRX-401

From the base station, WAVES can transmit two high-fidelity audio channels multiplexed 
with a full-duplex data channel that receives and transmits signals to on-site control and 
monitoring appliances. This enables the WAVES operator to transmit an audio broadcast 
and a voice announcement at any given time and synchronize them with a display message 
sent on the data channel.

Each TRX is programmed to receive communication from up to nine other TRXs. This 
provides increased reliability and survivability. In the event that the primary source TRX 
fails, the signal is automatically rerouted through secondary TRXs. Finally, the WAVES 
operator at the base station has full real-time control of each TRX's audio and data 
parameter settings, enabling the operator not only control of the audio and data settings 
but also ability to monitor each transceiver's operating parameters and status.

1.4.2.2 Radio-400 and Radio-500 (Field)

Radio-400 and Radio-500 units are VHF and UHF off-the-shelf radios, respectively, used 
as transceiver nodes operating on a single-frequency narrow band. Radio frequency 
settings are preprogrammed in manufacturing to customer specifications. Commands sent 
from the WAVES Base Station are received by the radio and played through configured 
devices. The radio also transmits messages and status reports upstream to the IBS.

FIGURE 1.8  Radio-400 VHF field transceiver

1.5 PERIPHERAL DEVICES
In WAVES, peripheral devices are any appliances that provide input or send messages into 
the WAVES system. For example, chemical detectors can be programmed to alert the fire 
department response team to what chemical agent type is dispersing and where it appears. 
Teams can don appropriate gear before arriving at the site and down-wind buildings can be 
immediately alerted to evacuate. In the event of a systematic intrusion, patterns of sensors 
show up immediately on the WAVES satellite map for the command unit to make 
appropriate responses to save lives. WAVES is also capable of activating other appliances, 
such as access-control bollards using custom-built interfaces. 
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Introduction
Sensor appliances configured in the WAVES network are capable of triggering assigned 
WACOL scripts that send messages to notification appliances. For example, when 
activated, a script can play prerecorded messages to speakers, cause strobes to flash or 
display a preset message on an LED sign. The scripts can be activated as needed or 
scheduled to play automatically to assigned sensor appliance. For information on creating 
scripts, refer to the WAVES 7 Administrator Manual or WAVES 7 Online Help for your 
system.

Examples of peripheral devices include the following:

• Wireless and Fixed Duress Activators - Sense input from users at remote 
locations. 

• Intrusion Detection Systems (IDS) - Sends detection status messages to 
WAVES.

• NBC/CBRN Detectors - Sends status and alarm messages to WAVES.

• WAVES Microphone - Sends live audio and command PTT messages to 
WAVES. 

Figure 1.9 displays some of the peripheral appliances that can be connected to the WAVES 
network.
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FIGURE 1.9 WAVES peripheral devices
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CHAPTER 2

Using the Network 
Configuration Tool 
The Network Configuration Tool provides access to administrator tasks that are essential 
in setting up unit parameters in the WAVES network. This chapter describes how to open 
the application and familiarizes the user with the screen components.

The following sections are included in this chapter.

• What is the Network Configuration Tool?

• Exploring the Screen Components

2.1 WHAT IS THE NETWORK CONFIGURATION TOOL?
The Network Configuration Tool allows the administrator to configure and define global 
and individual transceiver settings for devices in the WAVES system. 

• Global settings affect the entire installation site and include parameters internal to 
the WAVES application, as well as several parameters that are uniformly loaded 
into all transceivers. 

• Transceiver settings affect an individual unit and its behavior in the WAVES 
system. 

When an administrator opens the Network Configuration Tool, WAVES 7 remains open in 
the background, and, if there are any scripts in the scripts queue, asks the operator if it is 
OK to delete the currently queued scripts before opening the Configuration Tool. After the 
Network Configuration Tool opens, WAVES 7 is disconnected from the hardware network 
devices so that any 'inbound' messages from devices and any 'outbound', AreaAlert, or 
scheduled messages are discarded until the Configuration Tool is closed.

When the administrator closes the Configuration Tool, WAVES 7 automatically restarts 
the connection to the hardware network devices and a change to the database is noted on 
the WAVES Event List in the Status panel. In addition, the Event log will continue to log 
any scripts that attempted to play when the Configuration Tool was active.

You CANNOT send prerecorded audio or visual messages, or make live PTT 
announcements using the Network Configuration tool. Only global and unit 
properties settings and verification actions are permitted.
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Using the Network Configuration Tool
2.1.1 Launching the Application
For an existing base station, the NCT automatically opens the last launched database, 
which should be the same one that is open in WAVES 7. For a new base station database, 
you must identify the *.wvs file.

2.1.1.1 Opening the Configuration Tool for the First Time
1. From the WAVES 7 screen, login as Administrator.

2. From the Administration menu, select Network Configuration. The WAVES 7 
Off-Line dialog box appears advising you that the CRLU Service will be stopped 
while the Configuration Tool is open.

FIGURE 2.1 WAVES 7 Off-Line caution 

3. Click OK. The Network Configuration Tool opens displaying a blank WVS 
database. 

FIGURE 2.2 Blank Configuration Tool WVS database window

4. From the NCT screen, set the mode to On-line or Off-line and log in.

5. From the File menu, select Open. The Open a File dialog box appears.
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What is the Network Configuration Tool?
6. From the Look In list, open the C:\Waves\Data directory and open the same 
WVS database that is open in WAVES 7. (For example, 
C:\Waves\Data\StationAnywhere.wvs.) The database opens.

.

FIGURE 2.3 Open WVS database in Configuration Tool window

7. From the File menu, select Save. 

The next time you launch the Network Configuration Tool, the application will 
recognize the last database you saved and automatically open it.

2.1.1.2 Opening a Different Base Station WVS File
1. From the WAVES 7 screen, login as Administrator.

2. From the Administration menu, select Network Configuration. The WAVES 7 
Off-Line dialog box appears advising you that the CRLU Service will be stopped 
while the Configuration Tool is open.

3. Click OK. The Network Configuration Tool opens.

4. From the NCT screen, set the mode to On-line or Off-line and log in.

5. From the File menu, select Open. The Open a File dialog box appears.

6. From the Look In list, open the C:\Waves\Data directory and the desired WVS 
file. 

2.1.2 Closing the Application
1. From the File menu, select Save if any changes have been made.
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Using the Network Configuration Tool
2. Do one of the following:

− Click the  icon on the toolbar.

OR
− From the File menu, select Exit.

The application closes. 

The WAVES screen maximizes and any changes to the network configuration will 
be reflected in WAVES within seconds as it automatically restarts the network 
routing process. In addition, an event saying “WVS database changed” is added to 
the WAVES Event List in the Status panel.

2.2 EXPLORING THE SCREEN COMPONENTS
When the Configuration Tool opens it automatically opens the last saved database. 

FIGURE 2.4 Network Configuration Tool screen

2.2.1 Component Descriptions
The Network Configuration Tool toolbars contain buttons that correspond to many of the 
menu commands. While not all buttons will be used, you can find out what each one does 
by pointing to it and reading its tool tip. Table 2.1 below describes the main sections of the 
NCT screen, as well as menu options and command buttons that you may use.

Site Tree 
Panel

Toolbar

Action Panel

Database Name Bar

Menu Bar

Unit Details Panel
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Exploring the Screen Components
The following table identifies and describes ONLY the functional areas of the 
Network Configuration Tool interface that you will use. Because several tasks 
are performed from WAVES 7, not all NCT command buttons and menu 
options are discussed.

TABLE 2.1   NCT Screen Components Functions

Screen Area Function

Database 
Name Bar

Displays the opened *.wvs file name and its directory path.

Unit Details 
Panel

Displays selected site tree element(s). 

Site tree elements can be displayed as icons a list, or detailed list. See  the 
description for the View | Units option under “Menu Bar” in the Screen Area 
column.

Menu Bar Provides access to the following administrative and operator functions:

• File

− New  - Available only in Off-line, On-line, or Wired mode, 
allows you to open a blank window to create a new database.

− Open   - Available only in Off-line, On-line, or Wired mode, 
allows you to open the “Open a File” dialog box and choose an 
existing WVS database.

− Properties  - Available only in Off-line, On-line, or Wired 
mode, this option opens the ‘global’ site Properties dialog box 
from which unit parameters can be configured.

− Save  - Available in any mode, allows you to save an open file.

− Save As - Available in any mode, allows you to save an open file 
with a new name and/or to a different location.

− Exit  - Available in any mode, allows you to close the 
Network Configuration Tool.

• Edit

− New - Available only in Off-line, On-line, or Wired mode, allows 
you to add a new zone, sub-zone, or unit to the site tree. You can 
also right-click a zone or sub-zone and choose “New” from the 
shortcut menu, or press the “Insert” key.

− Cut  - Available only in Off-line, On-line, or Wired mode, 
allows you to cut a selected site tree element from its location.

− Copy  - Available only in Off-line, On-line, or Wired mode, 
allows you to copy a selected site tree element.
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Using the Network Configuration Tool
Menu Bar 
(continued) − Paste  - Available only in Off-line, On-line, or Wired mode, 

allows you to paste a cut or copied site tree element into a new 
location on the site tree.

− Rename - Available only in Off-line, On-line, or Wired mode, 
allows you to rename a selected site tree element. You can also 
slowly double-click the element to change the name or right-click 
the element and choose “Rename” from the shortcut menu.

− Delete - Available only in Off-line, On-line, or Wired mode, 
allows you to delete a selected site tree element. You can also 
right-click the element and choose “Delete” from the shortcut 
menu.

− Properties - Available only in Off-line, On-line, or Wired mode, 
this option opens a selected unit’s Properties dialog box. You can 
also right-click the unit and choose “Properties” from the shortcut 
menu.

• View

− WACOL Shell  - Available only in Off-line, On-line, or 
Wired mode, allows you to open the “WACOL Shell” dialog box. 
From the dialog box, you can enter or select a WACOL command 
to execute to a selected site tree element.

− Speaker Towers - Available in any mode, allows you to open the 
“Speaker Tower” dialog box. From the dialog box you can send 
prerecorded alarms or Built-in Audio Messages, initiate a self-test, 
and temporarily set the speaker tower volume.

− Volume Mute - Available in any mode, allows you to open the 
“Volume/Mute” dialog box. From the dialog box, you can adjust 
volume and mute settings for a site, zone, sub-zone, or unit.

− Toolbars - Available in any mode, allows you to hide or display 
toolbar elements and the Action Panel.

− Units - Available in any mode, allows you to display unit 
information in the Unit Details panel as:

• Large icons 

• Small icons 

• Vertical list 

• Vertical list with BIT details 
• Commands

− Monitor  - Available only in On-line and User mode, 
allows you monitor site conditions for a configured TRX.

TABLE 2.1   NCT Screen Components Functions

Screen Area Function
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Menu Bar 
(continued)

− Bit Result - Available in any mode when a “Request BIT” 
command has been issued, allows you to open the “BIT Results” 
window. From the window you can view the results of the BIT 
test.

− Peep Unit Info  - Available only in On-line, Wired, and User 
mode, allows you to open the “Monitor unit” window to peep a 
unit’s parameters.

− Verify - Available only in On-line, Wired, and User mode, allows 
you to open the “Verify Settings” window for a selected site tree 
element.

− DB to Unit - This option is currently not used.

−  Update All - This option is no longer in use.

− Version Update -Available only in Wired mode, allows you to 
open the “Version Update” dialog box. From the dialog box you 
can update a transceiver’s firmware version. 

− Wireless Update - Available only in On-line mode, allows you to 
open the “Wireless Firmware Update” dialog box. From the dialog 
box you can to update or reload a transceiver’s firmware.

− Change Password - Available only in Off-line, On-line, and 
Wired mode, allows you to change a user password.

− Change COM - Available only in Off-line, On-line, and Wired 
mode, allows you to open the “Select COM port” dialog box and 
select from a list of available communication ports.

− Export Data Base - Available in any mode, allows you to export 
the database file to a user specified file directory.

• Window

− Cascade, Tile vertical, Tile horizontal, Arrange icons - 
Available in any mode, allows you to arrange open dialog boxes 
on the screen.

• Mode

− Off-line, On-line, Wired, User  - Allows you to 
select and switch between user modes.

• Help

− Help - Allows you to open the PDF version of the Network 
Configuration Tool Administrator Manual.

− About - Available in any mode, allows you to open an information 
screen that contains Configuration Tool information.

TABLE 2.1   NCT Screen Components Functions

Screen Area Function

The “DB to Unit” command is obsolete and 
not compatible with the current database 
version. using the command will cause 
undesirable results in the database.
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Using the Network Configuration Tool
Toolbar Contains shortcut buttons to common administrator functions. 

•  Available only when a unit in the Unit Details panel is selected. 

Selecting a unit in the Unit Details panel and then clicking the arrow-
up folder button navigates the selected unit to the next lower folder or 
units inside its parent folder on the site tree.

•  Available only in Off-line, On-line, and Wired mode, and when a 
unit in the Unit Details panel is selected.

Selecting a unit in the Unit Details panel and then clicking the arrow-
down folder button navigates the selected unit into its parent folder on 
the site tree.

Site Tree 
Panel

Contains a graphical representation of the site database in an organized 
hierarchical tree format.

TABLE 2.1   NCT Screen Components Functions

Screen Area Function

For button descriptions other than those shown below, see 
the Menu Bar descriptions.
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CHAPTER 3

Creating a Functional Site Tree
The Network Configuration Tool’s site tree depicts a functional system view and a 
graphical representation of units in the WAVES network. This chapter describes how to 
build and organize the site tree. 

The following sections are included in this chapter.

• Understanding the Site Tree Structure 

• Navigating the Site Tree

• Selecting the Operating Mode

• Building the Site Tree

• Saving Database Files

• Backing Up the Database File

• Upgrading a WVS Database File

3.1 UNDERSTANDING THE SITE TREE STRUCTURE
The site tree is organized in a hierarchical tree format, in which the higher branches of the 
tree represent general areas and the lower branches are more specific. The site tree is 
presented on the left side of the Network Configuration Tool window. This same site tree 
and element names are referenced and seen in the WAVES 7 application.

All configuration procedures described in this chapter are normally carried 
out in Off-line mode by a WAVES Administrator.
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The highest branch of the site tree 
represents the entire/global site. The 
default global name for a new database 
site is “Theater”; however, you can 
change it to a more descriptive name. For 
example, in Figure 3.1 the site name has 
been changed to “Convention Center”. 
The different areas of the site are 
represented by the site elements: zones 
(z), sub-zones (s), and units (u).

FIGURE 3.1 Network Configuration Tool site tree

Zone and sub-zone branches appear below the site branch. For example, in Figure 3.1, 
“Main” is a zone and “Meeting Rooms”, “Ballrooms”, and “Restaurants” are its sub-
zones.

Units are the lowest branches on the site tree. Unit branches can appear under a zone or 
sub-zone branch. For example, in Figure 3.1, “Lobby” is in the “Main” zone and 
“Ballroom” sub-zone.

3.2 NAVIGATING THE SITE TREE
You can use the site tree to display the entire site or focus on one specific area of the site.

When you open a WVS file, the Network Configuration Tool displays the site and zone 
branches. An icon appears next to each branch to assist you in identifying the branch level.

FIGURE 3.2 Site tree branch icons

If you are working with a large site that contains many site elements, you may need to 
expand or collapse branches to obtain a general view of the site tree or focus on a specific 
branch. For example, you can view all the zones on the site tree by collapsing the branches 
under them or you can open all the branches under a specific zone.

A “+” sign to the left of a branch icon indicates that the branch contains collapsed 
branches. A “-” sign indicates that the branch has sub-branches and all the branches 
immediately under it are open. For example, all branches immediately under the “Main” 
branch in Figure 3.3 are open but branches under the “Meeting Rooms”, “Ballroom”, and 
“Restaurant” branches are hidden. “Lobby” and “Indoor Pool” do not have branches under 
them.

FIGURE 3.3 Expanded and collapsed site tree branches

Global Site Name
Zone Name

Sub-zone Name

Unit Name

Site Zone Sub-Zone Unit
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3.2.1 Expanding a Branch
• Double-click the branch name.

OR
• Click the “+” sign to the left of the branch icon.

3.2.2 Collapsing a Branch
• Double-click the branch name.

OR
• Click the “-” sign to the left of the branch icon.

3.2.3 Viewing Branch Details
You can view the details of a branch and the branches immediately under it in a table 
format in the Unit Details panel. The available details categories are selected on the 
Monitor BIT tab of the global Properties window. See Section 4.1.2, “Defining BIT 
Monitoring Parameters” on page 36 for instructions on configuring Monitor BIT tab 
options.

1. From the site tree, click a branch element.

2. Do one of the following:

− From the View menu, select Units, choose Icons, and then point to Details.

OR

− Click the  icon located on the toolbar.

The branch details appear in table format in Unit Details panel.

FIGURE 3.4 Branch element details
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3.3 SELECTING THE OPERATING MODE
You can work with the Configuration Tool in one of four operating modes:

• User 

• Off-line

• On-line

• Wired

Table 3.1, “Operating Modes Permissions” provides a task list and what mode is 
authorized to perform the task.

When you start the Network Configuration Tool application, User mode is active. The 
other three operating modes are password protected and allow access to administrative 
tasks.

User Mode - User mode allows you to view database statuses and perform general 
operational tasks, but no database operations (see Table 3.1, “Operating Modes 
Permissions” ).

Off-line Mode - Off-line mode allows you to work off-line to design a site tree and 
make changes to the design of existing site trees. You can also adjust the property 
settings of the base and field transceivers.

On-line Mode - On-line mode allows you to control on-line operation of the 
Configuration Tool through the connection between the computer at the base station 
and the base station transceiver. In this mode, you can receive BIT reports, design or 
make changes to the design of a site tree, adjust the property settings of the base and 
field transceivers, refresh the current operating parameters and reconfigure an entire 
site. To ensure the integrity of the site tree, it is recommended that you redesign the 
site tree off-line and only update the site tree after you are satisfied with the new 
design.

Wired Mode - Wired mode allows you to initialize the base and field transceivers. It 
is the only mode in which you can set Unit IDs and update a transceiver’s software 
version. Wired mode requires a direct cable connection between the PC and the 
transceiver being configured. The On-line and Wired modes operate at 19,200 bps.

TABLE 3.1   Operating Modes Permissions

Operation
User 
Mode

Off-line 
Mode

On-line 
Mode

Wired 
Mode

Peep unit internal parameters Yes No Yes Yes

Verify database parameters with actual unit 
parameters

Yes No Yes Yes

Save current settings Yes Yes Yes Yes

Open a file No Yes Yes Yes

Create a new file No Yes Yes Yes

Exit program Yes Yes Yes Yes

Copy unit No Yes Yes Yes

Cut unit No Yes Yes Yes

Paste unit No Yes Yes Yes

View/change unit properties (except for ID) No Yes Yes Yes
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* In the database only.

** Updates only the directly connected unit.

3.3.1 Changing the Operating Mode
1. From the Mode menu, select Off-line, On-

line, Wired, or User or click the desired 
mode’s icon from the Action panel. 

When changing from User Mode, the “Enter 
a password” dialog box may appear.

FIGURE 3.5 Action panel operating mode icons

2. If the Enter a password dialog box appears, enter the Password and click OK.

3.3.2 Changing the Password
1. Set the mode to Off-line, On-line, or Wired.

2. From the Commands menu, select Change Password. The Change Password 
dialog box appears.

FIGURE 3.6 Change Password dialog box

3. Enter the Old Password.

4. Enter the New Password.

5. Re-enter the New Password and click OK.

Change unit ID No Yes* No Yes

Change unit view Yes Yes Yes Yes

Rename unit No Yes Yes Yes

Change window view options Yes Yes Yes Yes

Send database to unit No No Yes Yes

Update version No No No Yes**

TABLE 3.1   Operating Modes Permissions (continued)

Operation
User 
Mode

Off-line 
Mode

On-line 
Mode

Wired 
Mode
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3.4 BUILDING THE SITE TREE
The site database is stored in a WVS file. To build the site tree, you must first create a new 
WVS database file.

3.4.1 Creating a New Configuration Tool Database File

1. From the WAVES 7 screen, login as Administrator.

2. From the Administration menu, select Network Configuration. The WAVES 7 
Off-Line dialog box appears advising you that the CRLU Service will be stopped 
while the Configuration Tool is open.

3. Click OK. The application opens displaying information for the database that was 
open in WAVES 7.

4. Set the mode to Wired ( ), On-line ( ), or Off-line ( ).

5. From the File menu, select New or click the  icon on the toolbar. The Close 
File dialog box appears. 

All operations defined in this section can be performed in any mode except 
User mode.

When working in Off-line or Wired mode, the Unit icon appears as a green 
block with a black question mark.
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6. Click Yes to save the file. A <new file> window opens.

FIGURE 3.7 New File window

An empty site tree appears on the left side of the window. The Configuration Tool assigns 
it the default site name, “Theater”. You can change the site name to a more appropriate 
name, especially if you have more than one site, as described in Section 3.4.3.

3.4.2 Defining Site Tree Elements
Zones, sub-zones, and units are site elements that represent the different branches of the 
site tree. The elements include the following:

• Zones  - Zones appear on the level just below the site name. You can define up 
to 31 zones.

• Sub-zones  - Sub-zones appear immediately below zones. You can define up to 
15 sub-zones under each zone.

• Units  - Units appear on the lowest level of the site tree. If you do not need a 
sub-zone, you can insert the unit directly under the zone. You can define up to 31 
units under a zone or sub-zone.

3.4.2.1 Element Addresses

When you define a site tree element, the Configuration Tool automatically assigns it a 
numeric address according to a strict numeric hierarchy. The hierarchy numbering is 
described below.
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• The address for a zone, sub-zone, or unit consists of three (3) numbers separated 
by commas (x,y,z) (where x is the zone number, y is the sub-zone number, and z is 
the unit number).

• The address number assigned to the first zone in a site is 1, and so on.

• The address number assigned to the first sub-zone of a zone is 1, and so on.

• The address number assigned to the first unit of a sub-zone is 1, and so on.

Examples of addresses for site tree elements 
shown in Figure 3.8 and described below.

• The top level address is 0,0,0 for the 
whole site (Theater), which is the root 
of the site tree.

• The address of the first zone is 1,0,0.

• The address of the first sub-zone is 
1,1,0 when it is added under the first 
zone.

• The address of the first unit is 1,1,1 
when it is added under the first sub-
zone.

• The address of the second unit is 1.1.2 
when it is added under the first sub-
zone.

FIGURE 3.8 Element addressing scheme

Site Tree Address
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3.4.2.2 Adding a Zone
1. Set mode to Wired, On-line, or Off-line.

2. Click the site name. For example, the site name in Figure 3.8 is “Theater”.

3. Do one of the following:

− Press the Insert key and then the Enter key.

OR
− Right-click the site name and select New from the shortcut menu. The new 

zone appears at the bottom of the site tree and an address is assigned to it. You 
can rename the Zone as described in Section 3.4.3.

3.4.2.3 Adding a Sub-Zone or Unit

1. Set mode to Wired, On-line, or Off-line.

2. Click a zone or sub-zone and do one of the following:

− Press the Insert key.

OR
− Right-click the zone or sub-zone and select New from the shortcut menu. The 

Select Type dialog box opens.

FIGURE 3.9  Select Type dialog box

3. Click Unit or Sub-Zone. The new unit or sub-zone appears and an address is 
assigned to it. You can rename the element as described in Section 3.4.3.

3.4.3 Renaming the Site and Elements
When you create a new site or site element, the Network Configuration Tool automatically 
assigns default names. You can change the default names to more appropriate ones at any 
time.

1. Set mode to Wired, On-line, or Off-line.

See Chapter 4, “Configuring Site Tree Elements” for information on defining 
the element parameters.

You can place up to 15,376 units (15,872 elements) in a tree structure.

See Chapter 4, “Configuring Site Tree Elements” for information on defining 
the element parameters.
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2. Select the site or a site element.

3. Do one of the following:

− From the Edit menu, select Rename.

OR

− Press the F2 key.

OR

− Right-click the element and select Rename from the shortcut menu.

4. Type the new name and press the Enter key.

3.4.4 Deleting Site Tree Elements

3.4.4.1 Deleting a Zone, Sub-Zone, or Unit

When you delete a zone or sub-zone element, you also delete all the site elements under it. 
For example, if you delete “North” in Figure 3.1, you also delete “Pool” and “Tennis 
Courts”.

1. Set mode to Wired, On-line, or Off-line.

2. On the site tree, click the site element you want to delete.

3. Do one of the following:

− On the Edit menu, click Delete.

OR

− Right-click the element and then select Delete from the shortcut menu. 

OR

− Press the Delete key.

The Delete Site dialog box opens.

4. Click Yes to delete the element or No to cancel the action. The element is deleted.

3.4.4.2 Deleting a Site
• Delete the file from your hard disk. For example, open the C:\Waves\Data 

directory, locate the file and delete it.

3.4.5 Reorganizing the Site Tree
You can easily reorganize unit groupings on your site tree and add new site elements by 
moving or copying sub-zones and units.

DO NOT use apostrophes or quotation marks in unit or group names.

Deleting a zone or sub-zone also deletes the elements subordinate to it.
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If you reorganize the site tree in Off-line mode and save the new addresses, you must later 
update the field transceivers in On-line mode to maintain the integrity of the site tree. See 
Chapter 4, “Configuring Site Tree Elements” for detailed instructions on setting and 
updating unit parameters.

3.4.5.1 Moving a Sub-Zone or Unit

1. Set mode to On-line.

2. Select the sub-zone or unit you want to move.

3. Drag the sub-zone or unit to the desired new location. The Move Site dialog box 
opens.

4. Click Yes to move the element or No to cancel the action. The sub-zone or unit 
appears in the new location and the Configuration Tool assigns new addresses to 
the relocated site element and all its subordinate branches.

5. Update the moved unit’s transceiver as described in Section 3.4.6, “Updating a 
Unit’s TRX”.

3.4.5.2 Copying a Unit

1. Set mode to Wired, On-line, or Off-line.

2. Select the unit you want to copy. 

3. From the Edit menu, select Copy or click the  icon on the toolbar.

4. Select the zone or sub-zone under which you want to place the duplicate element.

5. From the Edit menu, select Paste or click the  icon on the toolbar. The Copy 
Site dialog box opens.

6. Click Yes to paste the element or No to cancel the action. The copied unit appears 
in the new location and the Configuration Tool assigns it a new address.

7. Update the copied unit’s transceiver as described in Section 3.4.6, “Updating a 
Unit’s TRX”.

3.4.6 Updating a Unit’s TRX
When elements are moved or copied, you must update the unit’s TRX with its new 
address.

1. Set mode to On-line or Wired.

2. From the site tree, select the unit to be updated and right-click.

3. From the shortcut menu, select Properties. The unit’s Properties dialog box 
appears.

Changing the location of a sub-zone or unit on the site tree changes unit 
addresses. When you move a sub-zone or unit the Configuration Tool 
automatically assigns new addresses based on the site tree hierarchy.

When you copy a unit, the parameters of the unit are duplicated but the 
address is different.
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4. For each tab in the Properties dialog box, select a tab and click Update the Unit.

5. When finished, click OK to close the dialog box.

3.5 SAVING DATABASE FILES
After building the site tree, save the file for use at a later time.

1. Set mode to Wired, On-line, or Off-line.

2. From the File menu select Save or click the  icon on the toolbar. 

If this is the first time the file is saved, the Save a File dialog box opens. Do the 
following:

a. From the Save In box, locate the C:\Waves\Data directory.

b. Type a name for the file.

c. Click Save. The database is saved with a .wvs file extension.

3.5.1 Maintaining Different Unit Settings
You can maintain different sets of parameters for each unit in the site by saving them to 
different database files. 

For example, you may be responsible for the efficient operation of a stadium, in which one 
day a concert may take place and the next day a sports event. Each type of event could 
require very different unit groupings and audio settings.You can build a site tree 
containing all the transceivers currently located in the stadium and save it in different 
database files. You can then open one of the *.wvs files and rearrange the units into 
different groups and configure audio settings appropriate to a concert. Later you can open 
the other *.wvs file and rearrange the units into groups and configure audio settings 
appropriate for a football game.

3.5.2 Copying the Database to a New File
1. Set mode to Wired, On-line, or Off-line.

2. From the File menu, click Save As. The Save a File dialog box opens.

3. From the Save In box, locate the C:\Waves\Data directory.

4. Type a name for the new file.

5. Click Save. The Configuration Tool copies the contents of the original file into the 
new file and saves it with a .wvs extension.

3.6 BACKING UP THE DATABASE FILE
When the site design is complete, make a backup copy of the database and store it in a safe 
location. At a minimum, both *.wvs and *.mdb databases should be copied to a removable 
media such as floppy diskette or CD. 

Make sure the internal settings and Unit ID of each unit remain the same. 
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It is recommended, that you also manually record all unit and global properties in the 
event the removable media or database becomes corrupt.

3.6.1 Backing Up the Databases

1. From the File menu, select Save or click the  icon to save any changes to the 
database.

2. From the File menu, select Exit or click the  icon on the toolbar to close the 
Configuration Tool.

3. Open the C:\Waves\Data directory.

4. Hold down the Ctrl key and click the *.wvs and *.mdb files.

5. Right-click the highlighted files and choose Send To from the shortcut menu. 

6. Send the files to a 3-1/2 Floppy, CD, or other removable media. If access to an 
external backup device is available the entire C:\Waves directory can be backed 
up.

7. Close the C:\Waves\Data directory.

8. Label the media to indicate its contents and then store the media in a safe location.

3.6.2 Recording Unit and Global Properties
This procedure is optional but highly recommended in the event the removable media 
becomes corrupt. By manually recording the unit and global properties you can 
reconstruct the Network Configuration Tool database if necessary.

1. From the Network Configuration Tool, set the mode to On-line or Off-line.

2. Expand the site tree so that each unit can be seen.

3. From the site tree, select the first unit and open its properties dialog box by 

clicking the   (Properties) icon on the toolbar.

4. Do the following:

a. Record the unit name displayed on the dialog box's title bar.

b. From each tab, record the properties.

c. When finished, click OK to close the dialog box.

5. Repeat Step 4 for all site tree devices.

6. From the File menu, select Properties. The Properties dialog box for the entire 
site appears.

7. Do the following:

a. Record the site name displayed on the dialog box's title bar.

b. From each tab, record the settings. 

c. When finished, click OK to close the dialog box.

8. Click OK to close the Properties dialog box.

3.7 UPGRADING A WVS DATABASE FILE
WAVES NCT 5.6.x is fully compatible with WVS database files from WAVES NCT v5.4. 
No conversion is required when upgrading from that version. 
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To upgrade the WVS database file from WAVES v5.3 or earlier, follow the instructions 
outlined below.

1. Start WAVES 7 and login as Administrator.

2. From the Administration menu, select Network Configuration. The WAVES 7 
Off-Line dialog box appears advising you that the CRLU Service will be stopped 
while the Configuration Tool is open.

3. Click OK. The Network Configuration Tool opens.

4. Select On-line or Off-line mode, enter your password, and click OK.

5. From the File menu, select Open. The Open dialog box appears.

6. Locate the *.wvs file and click Open. The Open dialog box closes and a Close 
File dialog box appears.

7. From the Close File dialog box, click No.

8. From the File menu, select Save As.

9. Rename the file, saving it to the C:\Waves\Data directory.

10. Open the C:\Waves\Data directory.

11. Locate and rename the MDB file to match the newly renamed WVS file. The 
*.wvs and *.mdb file names must be identical for WAVES 7 to work.

12. Save and close the Network Configuration Tool.
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CHAPTER 4

Configuring Site Tree Elements
General site properties must be set to address the functional requirements at a site, as well 
as unique properties set for each transceiver. This chapter describes how to set up the site 
operating parameters.

The following sections are included in this chapter.

• Configuring Global Site Properties

• Configuring Transceiver Properties

• Verifying Database Integrity

• Exporting the Database to a Text File

• Updating TRX Firmware

4.1 CONFIGURING GLOBAL SITE PROPERTIES
Global property settings affect the whole site. These include parameters internal to the 
Network Configuration Tool application, as well as several parameters that are uniformly 
loaded into all transceivers.

The following site-wide properties should be set.

• Audio Mode

• BIT results

4.1.1 Audio Settings
Global audio settings allow you to determine how the audio channels are utilized and 
enable the automatic periodic refreshing of TRX volume and mute settings. 

For normal WAVES operation, the 'audio' channels A and B (I and II) are muted, the 
'voice' channels are not muted, and the 'audio mode' is always Mono 32. In WAVES, 'voice 
channels' refer to input from WAVES via the microphone or computer sound card.

Configuring site elements is a administrator function, therefore all procedures 
in this chapter are performed in Off-line, On-line, or Wired mode.
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By using WAVES 7 tools along with the Network Configuration Tool, volume levels can 
be set globally (theater), by zone or sub-zone, or for individual units. Changing the 
volume properties of an individual TRX at the 'unit level' changes only the settings for that 
TRX. Changing the volume properties of the theater, zone, or sub-zone affects the settings 
of all the TRXs located under their branches on the site tree.

Because the volume of an individual TRX is affected by the site, zone, and sub-zone 
settings, it is recommended that you configure volume settings in the order outlined in the 
WAVES 7 Administrator Manual or WAVES 7 Online Help for your system. Changing the 
theater, zone, or sub-zone volume after the unit volume has been set will cause a change in 
the unit volume. For example, if the Voice volume on a 'unit' is set to 40 dB and you 
change the Voice volume of the 'theater' to -5 dB, then the 'unit' will broadcast voice 
announcements at a volume of 35 dB (unit volume setting minus changed theater volume).

4.1.1.1 Audio Mode

Audio Mode defines the type of audio configuration supported by the transceivers. 

1. Set the mode to Off-line, On-line, or Wired.

2. From the File menu, select Properties. The site Properties dialog box opens.

3. Select the Audio Options tab.

4. From the Audio Mode list, select 32 mono and then click Update.

5. Click OK to close the dialog box.

For instructions on configuring audio settings, refer to the “WAVES Volume Settings” 
topic in the WAVES 7 Administrator Manual or WAVES 7 Online Help for your system.

4.1.2 Defining BIT Monitoring Parameters
The global properties Monitor BIT tab allows you to define which BIT parameters will 
display in the Unit Details panel when in Detail mode. WAVES 7 allows you to view BIT 
results; however, on rare occasion you may need to see additional information.

1. Set the mode to Off-line, On-line, or Wired.

2. From the File menu, select Properties. The site Properties dialog box opens.

3. Select the Monitor BIT tab. 

Setting the theater, zone, or sub-zone volume levels to non-zero values will 
affect the volume level of all units located under their site tree branch. 
Whenever you add a new transceiver to an existing network, you must reapply 
the group volume settings (theater, zone, and sub-zone).

To ensure units are broadcasting at their expected levels, configure volume 
settings as outlined in the WAVES 7 Administrator Manual or WAVES 7 
Online Help for your system.

To ensure units are broadcasting at their expected levels, confirm that your 
volume settings are also consistent with the “Instruction Sheet: Configuring 
WAVES Volume Settings” (P/N P40-00019).
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FIGURE 4.1 Monitor BIT settings tab

4. Do one of the following:

− Click the Select All button to choose all options.

OR 

a. Click the Select None button to clear all check boxes.

b. Select the Speaker Tower check box. 

c. Select any other desired parameter(s).

All selected BIT parameters will display in the Unit Details panel when in Detail 
mode.

Table 4.1 provides brief descriptions of the items that can be selected on the 
Monitor BIT tab. See Section 4.2.4, “BIT Parameters” for further descriptions.

5. Click Apply to save the new parameters.

6. Click OK to close the site Properties dialog box.

TABLE 4.1   “Monitor BIT” Parameter Descriptions

BIT Item Reported BIT Parameter Description

Addr Unit address (zone, sub-zone, unit #)

Speaker Tower Status reported from the external Speaker Tower or HPSA unit. Reports on 
Unit Details panel as None, OK, Fault, or Comm Fault.

RF AGC Current state of AGC. Reports on Unit Details panel as On or Off.

Last RSSI Read Relative signal strength of last hop packet received. Reports on Unit Details 
panel as 0 - 255.
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Audio CRC 
Failures

Simple 8-bit counter of CRC failures; 255 rolls over to 0. Reports on Unit 
Details panel as 0 - 255

Audio 
Miscorrelations

Simple 8-bit counter of the number of expected correlation sequences that 
were not detected; 255 rolls over to 0. Reports on Unit Details panel as 0 - 
255.

Battery Level Battery status. Reports on Unit Details panel as No, OK, or Low.

AC Supply AC power status. Reports on Unit Details panel as OK or Fail.

Link Enable RS-232 link status. Reports on Unit Details panel as Enable or Disable.

Audio Output 
Level

Last tested status of audio output circuit. Reports on Unit Details panel as 
OK or Fail.

Report Rate Reporting rate for BIT information, in tenths of a second. Reports on Unit 
Details panel as 10 - up

Source ID Unit ID of the current upstream relay. Reports on Unit Details panel as 1 - 
16383.

Antenna Relative signal strength of last packet received from downstream unit for 
relay to the CRLU. Reports on Unit Details panel as 0 - 100%.

BWD RSSI Relative signal strength of last packet received from a downstream unit for 
relay to the CRLU. Reports on Unit Details panel as 0 - 255.

BWD ID Low 8 bits of the Unit ID of the source of the last packet received from a 
downstream unit. Add multiple of 256 to this value to obtain the actual Unit 
ID. Reports on Unit Details panel as 0 - 255.

Quality State Indication of the integrity of the audio data being received. Switching 
between states is based on the number of CRC failures received within a 
given time period that varies from 2 to 20 seconds. Values are listed in order 
of increasing quality. Reports on Unit Details panel one of the following:

• After Switching - Designates that the unit just selected (switched 
to) a new upstream RF source.

• Voice Mute Designates the unit is synchronized with the upstream 
RF source but is not yet determined to be ready, no audio is passed 
through.

• Audio Mute - Designates the received signal is strong enough to 
attempt announcements but the reliability is not yet established.

• Low, Medium, and High - Designates the signal quality 
assessment based on the most recent CRC error counts. When the 
number of CRC errors decreases during a count period, the TRX 
reports a better Quality State.

TABLE 4.1   “Monitor BIT” Parameter Descriptions (continued)

BIT Item Reported BIT Parameter Description
38 WAVES Network Configuration Tool Administrator Manual v5.6.1
P/N P01-04912-C



Configuring Transceiver Properties
4.2 CONFIGURING TRANSCEIVER PROPERTIES
Transceiver properties are settings that affect an individual unit and its behavior in the 
system. 

4.2.1 Unit Audio Settings
Because the volume of an individual TRX is affected by the site, zone, and sub-zone 
settings, it is recommended that you configure volume settings in the order outlined in 
WAVES 7 Administrator Manual or WAVES 7 Online Help for your system. Changing the 
theater, zone, or sub-zone volume after the unit volume has been set will cause a change in 
the unit volume. For example, if the Voice volume on a 'unit' is set to 40 dB and you 
change the Voice volume of the 'theater' to -5 dB, then the 'unit' will broadcast voice 
announcements at a volume of 35 dB (unit volume setting minus changed theater volume).

Refer to Section 4.1.1, “Audio Settings” for additional information on audio settings.

4.2.1.1 Changing Unit Audio Properties
• Refer to the “WAVES Volume Settings” topic of the WAVES 7 Administrator 

Manual or WAVES 7 Online Help for your system.

4.2.1.2 Changing Site, Zone or Sub-Zone Audio Properties
• Refer to the “WAVES Volume Settings” topic of the WAVES 7 Administrator 

Manual or WAVES 7 Online Help for your system.

4.2.2 RS-232 Devices
The Configuration Tool allows you to set up different types of RS-232 peripheral devices 
such as display signs, sirens, wireless activators, individual building emergency systems, 
and chemical detector sensors. Refer to Chapter 5, “Setting Up Peripheral Devices” for 
instructions.

4.2.3 I/O SETTINGS
You can monitor and control site conditions from the base station by attaching external 
devices to the input and output pins of TRXs at key locations throughout your site and by 
configuring their digital I/O pins using the Network Configuration Tool. Each field TRX 
is equipped with one digital input pin and two digital I/O pins. 

When an external device is attached to the digital input and ground pin of a TRX, the TRX 
receives a high (5 V) or low (0 V) signal from the device. Once you have configured the 
digital setting in the NCT you can return to WAVES 7 to configure a response that is 
triggered when a defined condition for the digital device exists. 

Transceiver properties can be sent to the unit in Wired mode or On-line 
mode.

To ensure units are broadcasting at their expected levels, configure volume 
settings as outlined in the WAVES 7 Administrator Manual or WAVES 7 
Online Help for your system.
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4.2.3.1 Configuring Digital Pins
1. Set mode to Wired or On-line.

2. Select a unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

3. Select the I/O Settings tab.

4. Select the Monitor I/O on this unit check box. All digital input and I/O options 
become available.

FIGURE 4.2 I/O Settings tab

To configure Digital Input (J2 Pin 10 on the TRX):

a. From the Digital Input 1 box, select Active to activate the digital input pin.

b. Type a descriptive name in the Name box.

c. Select the Emergency priority check box. Emergency priority is not 
required, but is recommended. If not selected, the notification is not received 
by WAVES until the next regular BIT cycle of the TRX.

Digital I/O 2: Select 
“Auto-activate with PTT” to 
assert this output any time 
PTT announcements are made. 
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To configure Digital I/O 2 (J2 Pin 9 on the TRX):

a. From the Digital I/O 2 box, click the In button to activate the digital pin as an 
input or the Out button to activate the digital pin as an output.

b. Type a descriptive name in the Name box.

c. Select the Emergency priority check box. Emergency priority is not 
required, but is recommended. If not selected, the notification is not received 
by WAVES until the next regular BIT cycle of the TRX.

To configure Digital I/O 3 (J2 Pin 8 on the TRX):

a. From the Digital I/O 3 box, click the In button to activate the digital pin as an 
input or the Out button to activate the digital pin as an output.

b. Type a descriptive name in the Name box.

c. Select the Emergency priority check box. Emergency priority is not 
required, but is recommended. If not selected, the notification is not received 
by WAVES until the next regular BIT cycle of the TRX.

5. Click Update the Unit to send all the settings in the Properties dialog box to the 
transceiver.

6. Click OK to close the dialog box.

4.2.3.1.1 Prioritizing Digital Device Messages

A ‘normal sampling rate’ is based on the Report Rate defined in the BIT tab of the 
Properties dialog box. When an input is assigned an emergency priority status, the TRX 
overrides the Report Rate and sends a status message immediately to the CRLU. 
Emergency status messages also receive priority allocation of bandwidth to expedite their 
transmission to the base station. When configuring digital input or I/O settings, make sure 
to select the Emergency priority check box. Emergency priority is not required, but is 
recommended. If not selected, the notification is not received by WAVES until the next 
regular BIT cycle of the transceiver.

You can assign emergency priority to one or all of the digital inputs.

If Digital I/O 2 is configured as output (Out), checking the “Auto-activate with 
PTT” check box causes output to be asserted whenever the TRX makes a 
PTT announcement. For example, an attached strobe will automatically flash 
whenever audio is played to the unit. If the option is not checked, the strobe 
will only flash when an I/O ON command is issued.

If you are working in On-line mode, the settings are saved in the base station 
computer’s database after an acknowledgment is received. 

If you are working in Off-line mode, a message appears informing you that 
the data was not sent to the field transceiver and asking if you want to save 
the properties in the database. If you click Yes, the new settings are stored in 
the database. However, later you must update the field transceiver by 
switching to the On-line mode and sending the properties to the unit 
manually.
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To assign emergency priority to a digital input:

1. Select the unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

2. Select the I/O Settings tab.

3. Select the Emergency Priority check box for the desired activated digital 
device(s).

4. Click Update the Unit to send all the settings in the Properties dialog box to the 
transceiver.

5. Click OK to close the dialog box.

4.2.3.2 Monitoring TRX Digital Inputs

If you programmed a field TRX to send status messages to the base station computer by-
way-of the CRLU, you can monitor the condition of the transceiver’s digital inputs from 
the Network Configuration Tool or WAVES screens.

To monitor inputs from the Network Configuration Tool:

1. Set mode to User or On-line.

2. From the site tree, select a unit to be monitored.

3. From the Commands menu, select Monitor or click the  icon from the 
Action panel. The status monitor dialog box appears.

FIGURE 4.3 Status monitoring dialog box

The following transceiver statuses can be monitored on the status box. The name 
assigned to an active digital I/O pin appears above its graphic representation.

− Digital Input - A light appears below each digital input’s name. If the digital 
input receives a signal (activated), the light below its name turns red and the 
Event script for the digital input is activated if configured in WAVES 7.

− Digital Output - A switch appears below each digital output’s name. If the 
switch is turned ON, the output is 5 V. If the switch is turned OFF, the output 
is grounded.

Digital Input 
Indicator

Digital Output 
Switch
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4.2.4 BIT Parameters
Each field transceiver conducts two types of diagnostic built-in tests:

• Power-on-BIT (POB) - Tests the hardware configuration during power on.

• Online BIT - Tests the system’s ongoing operation.

If the transceiver is connected to a high-power speaker array (SPT/HPSA) or ACU it also 
reports the results of the unit’s internal BIT. Test results are reported at a defined rate or 
upon demand to the base station console.

When the BIT detects an unusual condition, the Configuration Tool graphically indicates 
the status of the field transceiver on the site tree by replacing the transceiver’s normal unit 
icon with special icons. The condition is also indicated on the WAVES operator screen by 
flashing icons or status indicators. Refer to the WAVES 7 Operator Manual or WAVES 7 
Online Help for more information on monitoring statuses from the WAVES 7 screen.

Table 4.2 below provides a description of the icons that display on the Network 
Configuration Tool site tree.

4.2.4.1 Setting BIT Parameters
1. Set mode to Wired, On-line, or Off-line.

2. From the site tree, select the TRX you want to run a BIT on and do one of the 
following:

− From the Edit menu, select Properties.

OR
− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

TABLE 4.2   BIT Condition Icons on the Site Tree

Icon Description

Red block with a yellow question mark. The base station did not receive BIT 
results from the unit. When the base station tried to contact the unit, it received no 
response.

Yellow loudspeaker with a red “X” across it. The Speaker Tower reported an error 
or is not communicating.

Red battery with a red diagonal line across it. The BIT detected that the backup 
battery power supply is low (has 10V or less).

Blue battery with a yellow lightning sign. The BIT detected that the unit is using 
its backup battery.

Blue battery with a red “X” across it. The BIT detected that the unit does not have 
a backup battery even though it is registered as having one.

Yellow block with a black exclamation mark. A problem exists with a connected 
RS-232 device.

Green block with black question mark. The system is off line and no statuses are 
being received.
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3. Select the BIT tab.

FIGURE 4.4 BIT settings tab

4. Do one of the following depending on the transceiver type:

For a TRX transceiver:

a. In the Report rate box, type or select the rate at which the TRX sends BIT 
messages to the CRLU. The default Report Rate is 60 seconds. Unless adding 
a new device, it is recommended that you leave the rate as set by the Cooper 
Notification Field Engineer to avoid the possibility of causing false 
indications.

b. Select the Has backup battery check box, to register the TRX backup battery 
if the TRX is attached to a UPS-901 and to check its status.

c. Select the Has AC supply check box, to register the TRX AC power supply if 
the TRX has an AC power cord attached to it and to check its status. 

d. Click Update the Unit to send all the settings to the TRX and then click OK 
to close the dialog box. 

For a VHF or UHF transceiver:

a. In the Report rate box, type or select 60 seconds as the rate at which the 
transceivers sends BIT messages to the Base VHF/UHF radio.

b. Clear the Has backup battery check box.

c. Clear the Has AC supply check box. 

d. Click OK to save the settings to the NCT database and close the dialog box. 

5. From the File menu, select Save to save changes to the WAVES 7 database.
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4.2.4.2 Manually Requesting BIT Results
1. Set mode to Wired, On-line, or Off-line.

2. From the site tree, select the transceiver you want BIT results from and do one of 
the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

3. Select the BIT tab and click Request BIT.

4. Click OK to close the dialog box.

5. See Section 4.2.4.4, “Viewing BIT and POB Results” for instructions on viewing 
the results.

4.2.4.3 Manually Requesting POB Results
1. Set mode to Wired, On-line, or Off-line.

2. From the site tree, select the transceiver you want POB results from and do one of 
the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

3. Select the BIT tab and click Request POB.

4. Click OK to close the dialog box.

5. See Section 4.2.4.4, “Viewing BIT and POB Results” for instructions on viewing 
the results.
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4.2.4.4 Viewing BIT and POB Results

The BIT Results window displays 
the results of a request for BIT and 
POB information for a transceiver. 
The name and address of the unit 
appear on the title bar. The 
window displays the BIT and POB 
results data from the transceiver.

1. With the unit from which 
you requested the BIT or 
POB report already 
selected, select the 
Commands menu.

2. Select BIT Result. The 
BIT Results window 
appears.

FIGURE 4.5 BIT results window

Many of the results displayed in the upper portion of the BIT Results window are used 
only for factory testing and may not show relevant information for the TRX operational 
status. These fields should not be relied upon to assess the condition of the transceiver 
hardware. Table 4.3 describes commonly referenced fields on the BIT Results window.

TABLE 4.3   Commonly Referenced BIT Results Descriptions

Field Description

Battery Reports the UPS-901 battery status as one of the following:

• 0 - No battery

• 1 - Low battery level

• 2 - Medium battery level

• 3 - High battery level

Output Level Reports the audio output level as one of the following:

• OK

• Fault

RSSI Reports the communication (receive) signal strength.

In a WAVES system, a minimum of 170 is required to meet the 
“Acceptable” level for signal strength and greater than 180 is “Good”. 
46 WAVES Network Configuration Tool Administrator Manual v5.6.1
P/N P01-04912-C



Configuring Transceiver Properties
Miss Correlations Reports the number of packets lost by the receiver (cumulative value 
with rollover at 255). When packets are lost, Audio CRC fail is also 
incremented.  When there are seven consecutive failures, the receiver 
starts to search for another source.

Source Reports the Unit ID of the current RF source.

RF agc Reports the receive attenuation status. Used for attenuation of strong 
signals. 

The following results are returned:

• On - Receive signal is attenuated.

• Off - Receive signal is not attenuated.

Audio CRC fail Reports the Audio CRC failures per second (cumulative value with 
rollover at 255) as one of the following:

• Increments of 0-2 failures per 10 seconds - Good reception.

• Increments of more than 20 failures per 10 seconds (the 
receiver will search for another source) - Poor reception.

Speaker Tower 
Status

Reports the Speaker Tower statuses as follows:

• Status - Reports the following:

− None if no SPT is defined.

− OK

− Fault if any of the criteria below are also “Fault”.

• Mains - When configured, reports the following:

− OK

− Fault if missing 120/240 charge voltage.

• Battery Volts 

− For SPT - When configured, reports actual voltage of 
battery. If less than 22.5 volts, status is fault; nominal 
voltage is 25 to 28 volts. 

− For HPSA - When configured, reports actual voltage of 
battery. If less than 45 volts, status is fault; nominal 
voltage is 50 to 56 volts.

• Amp 1-8 - Reports the following:

− OK

− Fault

TABLE 4.3   Commonly Referenced BIT Results Descriptions (continued)

Field Description
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4.2.4.5 Rebooting the TRX from the Configuration Tool
1. Set mode to Wired, or On-line.

2. From the site tree, select the transceiver that needs rebooted and do one of the 
following:

− From the Edit menu, select Properties.

OR

ACU Status The ACU Status only applies to the ACU-117 model. The ACU-340 will 
only report a yellow block with a black exclamation mark, meaning that 
a problem exists with a connected RS-232 device. 

Reports the ACU statuses as follows:

• Status - Reports the following:

− None if no ACU is defined.

− OK

− Fault if any of the criteria below are also “Fault”.

• External - Reports the following:

− OK

− Fault (typically a shorted speaker wire to the building 
ground).

• Battery - Reports the following:

− OK

− Fault if battery voltage is low or missing.

• Mains - Reports the following:

− OK

− Fault if missing 120/240 charge voltage.

• Microphone - Reports the following:

− OK

− Fault

• Amplifier - Reports the following:

− OK

− Fault

• Interface - Reports the following:

− OK

− Fault if missing status request from transceiver for 30 
seconds or more.

• Line Open/Line Short - Reports the following:

− OK

− Fault if speaker wires are disconnected or shorted 
together.

TABLE 4.3   Commonly Referenced BIT Results Descriptions (continued)

Field Description
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− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

3. Select the BIT tab and click Reboot the Unit.

4. Click OK to close the dialog box.

4.2.5 TRX Unit ID
Every TRX has a unique Unit ID number between 2 and 16,383 that is arbitrarily assigned 
at installation time. The Unit ID is the transceiver’s address in the WAVES system. It is 
used by the Configuration Tool to link each unit to its RF sources. For VHF/UHF Radio-
400/500 transceivers the Unit ID is preset in manufacturing.

A TRX may also be assigned an Installation ID. This identifier groups multiple units into 
an “installation group”. The Installation ID is used by TRXs operating in Lock Mode 
“AUTO” to only receive from sources within their own group. TRXs operating in Lock 
Mode “NORMAL” ignore the Installation ID.

4.2.5.1 Assigning Unit and Installation IDs to a TRX

1. Connect one end of the CAB-PC-ADU-3 cable to the Serial port of your PC and 
the other end to the RS-232 port of the TRX.

2. Set mode to Wired.

3. Select the unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

Assigning the unit and installation IDs applies only to TRX transceivers. 

For VHF/UHF Radio-400/500 transceivers the Unit ID is preset in 
manufacturing.

You must assign each unit a unique Unit ID between 2 and 16,383. 

TRX Unit ID and Installation ID parameters can only be set in Wired mode. If 
it is assigned in Off-line mode then the Configuration Tool saves it only in the 
base station’s computer database.
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4. Select the Unit ID tab.

FIGURE 4.6 Unit ID settings tab

5. In the Unit ID box, type a numeric value. 

Assign any number from 2 to 16,383. The eight least significant bits of the Unit 
IDs for each of a TRX’s children (RF listeners) should be different. See 
Section 4.1.2, “Defining BIT Monitoring Parameters”for instructions on 
configuring BIT parameters.

6. In the Installation Id box, type a name. This is an optional entry.

7. Click Update the Unit to send all the parameters to the TRX.

8. Click OK to close the dialog box. 

Do not set the Unit ID to 0 (zero). If set to 0, connection lines for RSSI will not 
display on the WAVES 7 map.
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4.2.6 Internal Parameters
Internal parameters must be set up for each transceiver. Required parameters differ for a 
TRX and a VHF/UHF radio. The following list describes the parameters you will see on 
the Internal Parameters tab. 

Unit Address - The Configuration Tool automatically assigns a unit address based on 
its position in the site tree and loads it when assigning the internal parameters. It is not 
modifiable from this window.

Unit Type - Defines the unit’s type as CRLU (base station transceiver), RLX (field 
receiver), PRLU (field relay), SRLU (satellite relay), or a backup CRLU (BCRLU).

Sw Mode - RF switching mode. May be defined as “Enabled” or “Disabled.” The 
“Enabled” state enables the TRX to search for an alternate RF source in case the 
quality of its current RF source drops below a preset limit. 

Lock Mode - “Auto” or “Normal”. In “Normal” mode the TRX will lock only onto an 
RF source from the RF Settings table. In “Auto” mode the TRX will lock onto the first 
received source with a matching installation ID and not on the Ineligible Sources list. 

TX Offset - A value selected for the transceiver’s forward RF transmissions. See 
Appendix A, “TRX Transmitting Offset Assignments” for a list of TX offset numbers.

RF Settings - Pairs of Unit IDs and Offset values for TRX units that serve as RF 
sources for the TRX being set up. Up to nine sources may be specified. This table is 
only active in Normal Lock Mode. 

Ineligible Sources - A table of unit IDs of the RF sources that the TRX may not 
receive from. This table is only active in Auto Lock Mode. 

SRLU - When the unit type is an SRLU or Backup CRLU, the user may choose the 
primary source of the audio and voice channels. Two choices are available: Base and 
Local. When “Base” is selected, the primary source is the CRLU. When “Local” is 
selected, the primary source is the SRLU. 

4.2.6.1 TRX Internal Parameters

The TRX is a transmitter node in the WAVES wireless network that receives and plays 
messages addressed to them using FHSS technology to broadcast RF signals over a wide 
range of frequencies. Frequency offsets are used to spread RF signals. Receiving stations 
use their frequency offset settings to recognize and retrieve RF signals directed to them.

If you are working in Wired mode, the settings are saved in the base station 
computer’s database after an acknowledgment is received. 

You cannot assign a Unit ID in On-line mode. You can assign it in Off-line 
mode, in which case a message appears informing you that the ID was not 
sent to the field transceiver and asking if you want to save it in the database. 
If you click Yes, the new settings are stored in the database. Later you must 
update the field transceiver as follows:

a. Connect one end of the CAB-PC-ADU cable to the Serial port of your 
computer and the other end to the RS-232 port of the TRX.

b. Switch to Wired mode and click Update the Unit on the Unit ID tab of 
the Properties dialog box.
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4.2.6.1.1 Setting TRX Internal Parameters for “Normal Mode”

1. Select the unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

2. Select the Internal Parameters tab.

FIGURE 4.7 Internal Parameters settings tab

Setting up TRX Internal Parameters is most efficiently done in Wired mode. 
That way, the unit does not need to re-sync with its sources. However, 
Internal Parameters may be set in On-Line mode, except if the unit is a 
CRLU.
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3. From the Unit Type list box, select the type of unit.

4. From the Lock Mode list box, select Normal.

5. In the RF Settings box, enter the RX ID and Offset parameters as per the RF 
plan. See Appendix A, “TRX Transmitting Offset Assignments” for a list of 
transmit offset numbers.

6. Click Update the Unit to send all the settings to the TRX.

7. Click OK to close the Properties dialog box.

8. Verify that the unit reports an OK status (blue icon) on the site tree. 

4.2.6.1.2 Setting TRX Internal Parameters for “Auto Mode”

1. Select the unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR
− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

2. Select the Internal Parameters tab.

3. From the Unit Type list box, select the type of unit.

4. From the Lock Mode list box select Auto.

5. If applicable, in the Ineligible Sources box, enter the unit IDs of RF sources that 
the unit may not receive from.

6. Click Update the Unit to send all the settings to the TRX.

7. Click OK to close the Properties dialog box.

4.2.6.2 VHF or UHF Radio Internal Parameters

Radio-400 and Radio-500 are VHF and UHF transmitter nodes in the WAVES wireless 
network that receive and broadcast messages addressed to them on a single frequency, 
narrow band. Frequency settings are preprogrammed per customer specifications.

If you select SRLU or Backup CRLU as the Unit Type, the Audio and Voice 
source selections appear within the SRLU group box. 

a. In the SRLU box, select one of the following Audio sources: Base for 
CRLU input or Local for SRLU input.

b. Select one of the following Voice priority: Base to give CRLU voice 
messages priority over local announcements, Local to give priority to 
local PTT messages.

Setting up TRX Internal Parameters is most efficiently done in Wired mode. 
That way, the unit does not need to re-sync with its sources. However, 
Internal Parameters may be set in On-Line mode, except if the unit is a 
CRLU.
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1. Select the unit on the site tree and do one of the following:

− From the Edit menu, select Properties.

OR
− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

2. Select the Internal Parameters tab.

3. From the Unit Type list box, select RLX.

4. From the TX Offset box, use the default setting of “2”.

5. Click Update the Unit to send all the settings to the unit.

6. Click OK to close the Properties dialog box.

4.3 VERIFYING DATABASE INTEGRITY

4.3.1 Peeping Unit Information
You can monitor a transceiver’s internal parameters by using the Peep Unit Information 
option on the Configuration Tool. 

1. Set mode to On-line, Wired, or User.

2. Select a unit on the site tree.

3. From the Commands menu, select Peep Unit Info or click the  icon. The 
Monitor Unit dialog box appears.

 

FIGURE 4.8 Monitor Unit dialog box

It may take several seconds for the unit information to appear. 

Different transceiver types report different information. The dialog box 
automatically adjusts itself to the information contained within it.
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4.3.1.1 Refreshing the Monitor Unit Data
• From the Monitor Unit dialog box, click Refresh.

4.3.1.2 Closing the Monitor Unit Dialog Box
• From the Monitor Unit dialog box, click Close.

4.3.2 Using the Verify Command
The Verify command compares the contents of a transceiver’s internal database with the 
intended settings as they appear in the WVS database. 

1. Set mode to On-line, Wired, or User.

2. From the site tree, select the unit you want to verify.

3. From the Commands menu, select Verify. The Verify Settings for Unit dialog box 
opens. 

FIGURE 4.9 Verify Settings for Unit dialog box

Each database entry that matches will display a blue O.K. A database entry that does not 
match will display a red ERROR. To correct an error, update the unit with the correct 
parameters.

The “Audio Settings” category compares the current TRX settings with the stored 
‘default’ setting (not the current database setting) and will report “ERROR” if the TRX 
settings are not the default settings.

4.3.2.1 Refreshing the Verify Settings Data
• From the Verify Settings for Unit dialog box, click Refresh.

4.3.2.2 Closing the Verify Settings Dialog Box
• From the Verify Settings for Unit dialog box, click Close.

4.4 EXPORTING THE DATABASE TO A TEXT FILE
You can export database information as a text file and then print the file. The report 
includes the following information:

• Unit Internal Settings

− Address
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− ID

− Type

− Tx Offset

− Installation ID

− Switching and Lock Modes

− BIT Reporting Rate

− External Device Settings

− SRLU/Backup CRLU Audio Sources

− RF Sources

• Unit Design Settings

− Theater, Zone, Sub-Zone, or Unit Name

− Associated Bitmap File (if any)

• Unit Audio Settings

− System Audio Mode

− Volume Settings (Zone and sub-zone numbers are relative, unit settings are 
absolute, corresponding to the numbers shown in the Properties window.)

− Bass and Treble Settings (for Units only)

− Mute Settings 

• Wireless Activator families

− WA Family Number

− WA Family Name

4.4.1 Exporting and Printing the Database
1. From the Commands menu, select Export Data Base. The Export DataBase 

confirmation dialog box appears.

2. Click Yes to export the database to TXT file or No to cancel the action. If Yes was 
selected, the Save a File dialog box appears.

3. Enter the File name and click Save. The default location for the saved file is 
C:\Waves\Data.

4. Open the C:\Waves\Data directory and locate the file. 
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Updating TRX Firmware
5. Open the file with an ASCII editor, such as Notepad, and then print the file using 
the standard Windows printing procedure.

FIGURE 4.10 Database exported as a text file

4.5 UPDATING TRX FIRMWARE
On occasion it will be necessary to update or reload the TRX’s firmware. 

There are two methods for updating the TRX firmware: Wired Update and Wireless 
Update.

See Appendix B, “TRX Firmware Update Procedures” for instructions.
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CHAPTER 5

Setting Up Peripheral Devices
A WAVES system can include several types of peripheral devices that enhance the 
message and alarm notifications to personnel. This chapter describes administrator 
procedures for configuring peripheral devices in the Network Configuration Tool.

The following sections are included in this chapter.

• Display Signs

• Speaker Tower (SPT)

• High-Powered Speaker Array (HPSA)

• Wireless Activator System (WA)

• Nuclear, Biological, and Chemical (NBC) Detectors

• Autonomous Control Unit (ACU)

• Digital Output Devices

5.1 DISPLAY SIGNS
The WAVES system supports several types of visual display signs. You must configure 
sign properties before the sign can execute a script from WAVES 7 to display a message. 

5.1.1 Setting the Display Sign RS-232 Type
1. Set mode to On-line.

2. From the site tree, select the unit that is connected to a display sign and do one of 
the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.
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3. Select the RS-232 devices tab. 

FIGURE 5.1 RS-232 devices - display sign settings

4. From the Select display driver box, choose <ASCII>.

5. From the Display baud rate box, click the arrow and select the correct rate.

− For Galaxy 3010, 3020, or G200 display signs: Select 19200.

− For an InfoNet display sign: Select 9600.

6. Click Update the unit and then OK to close the Properties dialog box.

5.2 SPEAKER TOWER (SPT)
The SPT is a high-powered siren system designed to broadcast live or prerecorded 
messages for public warning in cases of emergency, natural disasters, or military conflicts. 
This peripheral device acts as a node in the WAVES network that communicates through 
an RS-232 interface connected to a TRX located inside the SPT electronics enclosure. For 
For instructions on configuring the SPT settings, see the SPT Installation and User 
Manual.

5.3 HIGH-POWERED SPEAKER ARRAY (HPSA)
Like the SPT, the HPSA is also a high-powered siren system designed to broadcast live or 
prerecorded messages for public warning. As a peripheral device, it acts as a node in the 
WAVES network that communicates through either a TRX or UHF/VHF Radio-400/500 
transceiver located inside the HPSA electronics enclosure. For instructions on configuring 
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Wireless Activator System (WA)
the HPSA settings, see the either the HPSA-3000 Series Installation and User manuals or 
HPSA-4000 Series Installation and User Manual. 

5.4 WIRELESS ACTIVATOR SYSTEM (WA)
The Wireless Activator System allows personnel to remotely communicate with a WAVES 
Base Station to issue notification of critical alarm and emergency events. The system 
consists of the following:

• Wireless Activator Transmitter (WTX) 

• Wireless Activator Receiver (WRX)

FIGURE 5.2 WA System devices

After WA devices have been defined and configured in the Network Configuration Tool 
database, the administrator can then assign activators and set up WA events in WAVES 7. 
The following WA events can be configured:

• Alarm - An event triggered when the white button on a WA Activator is pressed 
and when the WA Receiver is not already in Alarm or Emergency mode. 

When triggered, the activator number appears, flashing on the right side of the 
WA Receiver’s (WRX) LED panel.

• Emergency - An event triggered when the red button on the WA Activator is 
pressed and when the WA Receiver is not already in Emergency mode. 

When triggered, the activator number appears, flashing on the left side of the LED 
panel.

• LowBattery - An event triggered when an activator determines that its battery 
power is low.

• NotExists - An event triggered when an activator is lost from the receiver's list of 
known activators, or regained communications.

5.4.1 Defining Wireless Activator System Properties
The WRX initiates a change-of-state warning by communicating with a TRX unit by-way-
of the unit’s RS-232 port. Each group of activators is called a “family” and is assigned a 
family name. Each individual WTX is assigned a unique identifier, identifying it to its 
own WRX. 

Receiver LED 
Indicator Panel

“Alarm” 
indication 
flashes on 
right side

“Emergency” 
indication 
flashes on 
left side

Activator 
Buttons

WTX (Transmitter) WRX (Receiver)
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5.4.1.1 Defining WA Families
1. Set the mode to Off-line, On-line, or Wired.

2. From the File menu, select Properties.

3. Select the Activator Families tab.

4. Click New Family. A new WA 
family named “Family <#>” is 
added to the list box.

5. Select the newly added family and 
click Rename. The Edit name 
dialog box appears.

6. Enter a new name for the family 
and click OK.

FIGURE 5.3 Activator Families settings tab

7. From the list box, select the family and click Properties. The Activator Definition 
Table appears.

8. From the Activator Definition Table, for each transmitter address click its “In-
Use” button.The WRX can communicate with up to 23 activators. 

FIGURE 5.4 Activator Definition Table

9. Click Apply to save the new setting and then OK to close the dialog box.

10. Click OK to close the Properties dialog box.

Each family represents a 
WRX and all WTXs 
associated with it.
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Wireless Activator System (WA)
5.4.1.2 Configuring the TRX for WA Communication
1. Set the mode to Off-line, On-line, or Wired.

2. Click the unit on the site tree that is connected to the WRX.

3. Do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the element and select Properties.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

4. Select the RS-232 devices tab.

FIGURE 5.5 Defining a WRX Receiver RS-232 device

5. From the Select type(s) box, select the WA Receiver radio button. 

6. From the Wireless Activator Families list box, select the family you wish to 
assign to the WRX.

7. Click Update the unit to send all the settings to the TRX.

8. Set other properties as described in Section 4.2, “Configuring Transceiver 
Properties”.

9. Click OK to close the dialog box.
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10. Set up wireless activator events as described Section 5.4.2, “Setting Up WA 
Events”.

5.4.2 Setting Up WA Events
WA events are defined in WAVES 7 to announce activator activity. Refer to the WAVES 7 
Administrator Manual or WAVES 7 Online Help for your system for instructions on setting 
up WA events. 

5.4.3 Monitoring Wireless Activators
WA activity is monitored from the WAVES 7 screen by an operator. Refer to the WAVES 7 
Operator Manual or WAVES 7 Online Help for instructions on monitoring wireless 
activators.

5.5 NUCLEAR, BIOLOGICAL, AND CHEMICAL (NBC) 
DETECTORS

The Network Configuration Tool, when coupled with the appropriate TRX firmware 
version, adds the capability to interface with specialized sensors through the TRX RS-232 
port. The firmware provides interface protocols for communication with the following 
sensor devices.

• RAE Systems® ppbRAE detector (with firmware version 1.22, or later)

• Smiths Detection® GID-3 detector (with DWIU-enabled firmware)

The TRX periodically polls the sensors for data and reports the data to WAVES, where an 
operator monitors the system for alerts. 

After detectors have been defined and configured in the Network Configuration Tool 
database, the administrator can then set up detector events in WAVES 7.

5.5.1 Configuring the TRX for NBC Detector Communications

1. Set mode to Wired or On-line.

2. From the site tree, select the unit that is connected to an NBC detector and do one 
of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears.

3. Select the RS-232 devices tab.

The TRX must be running a compatible firmware version to interface with the 
sensor. Contact Cooper Notification/MadahCom Customer Support if 
assistance is needed.
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Nuclear, Biological, and Chemical (NBC) Detectors
4. From the Select type(s) box, click the Sensor radio button.

FIGURE 5.6 RS-232 devices tab - Sensor settings

5. In the Poll Interval box, type or select the polling interval, in tenths of a second 
(i.e., 40 = 4 seconds). The TRX will poll the sensor for data at this interval. Valid 
values are from 10 to 60 tenths of a second. A value of zero disables polling.

6. From the Select sensor type box, choose the chemical detector type.

7. From the Sensor baud rate box, select the baud rate.

8. Click Update the unit to send all the settings to the TRX.

9. Set other properties as described in Section 4.2, “Configuring Transceiver 
Properties”.

10. Click OK to close the dialog box.

11. Set up detector events as described Section 5.5.2, “Setting Up NBC Detector 
Events”.

5.5.2 Setting Up NBC Detector Events
Detector events are set up in WAVES 7 to announce detector activity. Refer to the WAVES 
7 Administrator Manual or WAVES 7 Online Help for your system for instructions on 
setting up NBC events. 
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5.5.3 Monitoring NBC Detectors
Detector activity is monitored from the WAVES 7 screen by an operator. Refer to the 
WAVES 7 Operator Manual or WAVES 7 Online Help for instructions on monitoring gas 
detectors.

5.6 AUTONOMOUS CONTROL UNIT (ACU)
The ACU is an individual building mass notification system that can be connected to a 
base-wide WAVES system.

It includes a WAVES audio command center that is a state-of-the-art Emergency Voice 
Evacuation Control Panel, which provides the ability to dispatch several preprogrammed 
messages from a local operator console. The system is also capable of delivering live 
voice messages using an integral microphone. 

FIGURE 5.7 ACU communications

When an optional TRX is added to the ACU, the TRX functions as the audio and data 
input/output node when the system is in base-wide mass notification mode.

The ACU also integrates with fire alarm systems by providing a deactivation signal for 
fire-alarm audible notification appliances while WAVES delivers voice messages.

After the ACU has been configured in the Network Configuration Tool database, the 
administrator must define the ACU type in WAVES 7.

5.6.1 Configuring a Transceiver for ACU Communications 
1. Set mode to Wired or On-line.

2. From the site tree, select the ACU and do one of the following:

− From the Edit menu, select Properties.

OR
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Autonomous Control Unit (ACU)
− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

3. Select the RS-232 devices tab.

4. From the Select type(s) box, click the ACU radio button.

FIGURE 5.8 RS-232 devices tab - ACU settings

5. Click Update the unit to send the setting to the transceiver and then OK to close 
the dialog box.

6. Set other properties as described in Section 4.2, “Configuring Transceiver 
Properties”.

7. Repeat Step 2, to reopen the unit’s Properties dialog box. A new tab appears in the 
dialog box, “ACU Properties”.

8. Select the ACU Properties tab.

The ACU Properties tab only appears after the unit has been configured as 
an ACU on the RS-232 devices tab.
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FIGURE 5.9 ACU Properties settings tab

9. From the Number of Available Messages list, select the number that represents 
how many PB-2 through PB-8 buttons are actually green back-lit (active) on the 
front of the ACU control panel.

10. Click Time Sync to synchronize the ACU log reports to the computer clock. In 
normal operation, WAVES does this automatically at startup and once per day 
thereafter.

11. Click Apply to save the settings and then OK to close the dialog box. 

5.6.2 Identify the ACU Type
Before ACU messaging can begin you must identify the type of building emergency 
system installed at your site. This is done from WAVES 7. Refer to the WAVES 7 
Administrator Manual or WAVES 7 Online Help for instructions.

5.6.3 Activating ACU Messages
ACU messages are activated from the WAVES screen using buttons and scripts set up by 
the WAVES Administrator. See the WAVES 7 Operator Manual or WAVES 7 Online Help 
for instructions.

5.6.4 Monitoring the ACU Status
ACU status is monitored from the WAVES 7 screen by an operator. Refer to the WAVES 7 
Operator Manual or WAVES 7 Online Help for instructions on monitoring devices.
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5.7 DIGITAL OUTPUT DEVICES
WAVES 5.6.1 and higher allows you to configure automatic activation of output devices, 
such as strobes, that are attached to Digital I/O 2 (J2 Pin 9 on the TRX) and can be turned 
on by a 5-Volt signal. 

To set auto-activate digital output devices:

1. Set mode to Wired or On-line.

2. From the site tree, select the unit (the output device must be attached to Digital 
I/O J2 Pin 9 on the TRX) and then do one of the following:

− From the Edit menu, select Properties.

OR

− Right-click the unit and select Properties from the shortcut menu.

OR

− Click the  icon on the toolbar.

The unit’s Properties dialog box appears. 

3. Select the I/O Settings tab.

FIGURE 5.10 Auto-activate digital output device

Digital I/O 2: Select 
“Auto-activate with PTT” 
to assert this output 
any time PTT 
announcements are made. 
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4. From the Digital I/O 2 box, click the Out button to activate the digital pin as 
output signal.

5. Type a descriptive name in the Name box.

6. Select the Auto-activate with PTT check box.

7. Click Update the Unit to send all the settings in the Properties dialog box to the 
transceiver.

8. If necessary, set other properties as described in Section 4.2, “Configuring 
Transceiver Properties”.

9. Click OK to close the dialog box.

If Digital I/O 2 is configured as output (Out), checking the “Auto-activate with 
PTT” check box causes output to be asserted whenever the TRX makes a 
PTT announcement. For example, an attached strobe will automatically flash 
whenever audio is played to the unit. If the option is not checked, the strobe 
will only flash when an I/O ON command is issued.
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APPENDIX A

TRX Transmitting Offset 
Assignments
This appendix presents the recommended transmitting offset assignment order for a 
WAVES site.

The following sections are included in this appendix.

• Using Transmitting Offset Numbers

• Transmitting Offset Numbers List

A.1 USING TRANSMITTING OFFSET NUMBERS
An offset number is an RF frequency value assigned by you to a CRLU-201 or TRX-401 
that enables it to recognize which RF signals to accept and which to ignore. The following 
list provides important information when assigning offset numbers.

• Assign “0” as the transmitting offset of the CRLU and “2” to those transceivers 
configured as RLXs on the Internal Parameters tab of the unit’s Properties 
dialog box.

• Offset numbers can be reused on the same site IF the two TRXs are not within RF 
range of each other. 

• To avoid transmission difficulties, make sure that you do not assign similar 
transmitting offsets to field transceivers defined as PRLUs in the same area. For 
example, do not assign “5” and “7” to two field transceivers located close to each 
other.
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A.2 TRANSMITTING OFFSET NUMBERS LIST
The following table lists the recommended transmitting offset assignment order.

TABLE A.1   RF Transmit Offset Numbers

Item Offset # Item Offset # Item Offset #

CRLU 0 25. 60 51. 48

RLX 2 26. 12 52. 20

1. 31 27. 50 53. 64

2. 13 28. 66 54. 15

3. 53 29. 40 55. 49

4. 5 30. 9 56. 4

5. 23 31. 74 57. 58

6. 43 32. 36 58. 26

7. 67 33. 14 59. 51

8. 3 34. 30 60. 35

9. 37 35. 55 61. 62

10. 59 36. 38 62. 72

11. 11 37. 18 63. 54

12. 73 38. 63 64. 25

13. 47 39. 27 65. 42

14. 7 40. 44 66. 28

15. 17 41. 75 67. 68

16. 41 42. 21 68. 8

17. 71 43. 34 69. 39

18. 19 44. 52 70. 46

19. 29 45. 69 71. 32

20. 61 46. 16 72. 56

21. 70 47. 57 73. 1

22. 24 48. 33 74. 22

23. 45 49. 65

24. 6 50. 10
72 WAVES Network Configuration Tool Administrator Manual v5.6.1
P/N P01-04912-C



APPENDIX B

TRX Firmware Update 
Procedures
On occasion it may be necessary to update or reload the TRX’s firmware. This appendix 
provides instructions for updating the firmware.

The following sections are included in this appendix.

• Firmware Updating Methods

• Wired Mode

• Wireless / On-Line Mode

B.1 FIRMWARE UPDATING METHODS
There are two methods for updating the TRX firmware:

• Wired Mode

• Wireless / On-line Mode

The Wired method is faster and less disruptive to system operations than a Wireless update 
making it the preferred method. However, under special circumstances, where access to a 
TRX unit is restricted, the Wireless update method may be preferable. 

The firmware update is a two-step process. First, the hex file containing the binary code is 
transferred to a buffer within the unit. When this step is successfully completed, the 
content of the buffer is burned into the TRX unit’s on-board memory. 

B.2 WIRED MODE
1. Disconnect the TRX power cable from its power source. The TRX turns off.

2. Connect one end of the CAB-PC-ADU-3 cable to your computer Serial port and 
the other end to the TRX RS-232 port.

3. From the Network Configuration Tool, set mode to Wired.
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4. From the Commands menu, select Version Update. The Version Update dialog 
box appears.

FIGURE B.1 Version Update dialog box

5. From the Hex File Name box, do one of the following:

− Enter the appropriate file name and add the .hex extension to the end of the 
name.

OR
− Click the magnifying glass and locate the file.

6. Click Update Version. The message “Waiting for Ready to Receive” appears.

7. Immediately (within 5 seconds) plug the TRX power cable into its power source 
to turn the TRX on.

A series of messages are issued documenting the actions taking place. The update 
progress can be seen from the Version Update Progress box on the Version Update 
dialog box.

8. Verify that the update was successful by selecting the Commands menu and 

choosing Peep Unit Info or by clicking the  icon. The Monitor unit window 
opens.

9. Check the version number and ensure it matches the newly installed update.

Be prepared to plug the TRX power cable back into its power source within 5 
seconds AFTER clicking the Update Version button.

MAKE SURE ELECTRICAL CONNECTIONS ARE SECURE BEFORE 
APPLYING POWER TO A UNIT. FAILURE TO SECURE CONNECTION 
MAY CAUSE AN ELECTRICAL ARC RESULTING IN PHYSICAL SHOCK 
OR DAMAGE TO EQUIPMENT.
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Wireless / On-Line Mode
B.3 WIRELESS / ON-LINE MODE

1. Open the Network Configuration Tool as described in Section 2.1.1, “Launching 
the Application”.

2. Set the mode to On-line.

3. From the site tree, select the zone, sub-zone, or unit to be updated.

4. From the Commands menu, select Wireless Update. The Wireless Firmware 
Update dialog box appears.

FIGURE B.2 Wireless Firmware Update dialog box

5. From the Address box, verify that the address is correct for the selected TRX.

6. From the Firmware Version box, do one of the following:

− Enter the appropriate file name and add the .hex to the end of the name.

OR

A CRLU cannot be programmed using the wireless method.

When a zone or sub-zone that contains multiple units is selected as the site 
tree target their units will be listed separately in the Units’ update status list 
box of the Wireless Firmware Update dialog box (see Figure B.2). 

Avoid attempting updates to groups of more than 15 units as the probability 
of success is diminished.
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− Click the magnifying glass and locate the file.

7. Click Start. Acknowledgment is provided informing you that the file transfer is in 
progress. Also, a progress bar indicates the number of bytes being sent to the TRX 
unit.

8. From the Units’ update status list box, verify that the file transfer process was 
successful by checking the Transfer Status column. 

If the transfer was not successful, click Start again.

9. From the Units’ update status list box, highlight the unit(s) you want to update 
and click Program Units. The follow actions occur:

− A message appears informing you that the program command was sent. 

− The TRX’s Sync indicator LED flashes quickly, indicating that firmware 
loading is in progress. 

10. Upon successful completion of the programming, a message appears informing 
you that the unit is back on and displays the new firmware version.

11. Click Close. 
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APPENDIX C

Configuring the RF AGC Setting
When a TRX is shipped the RF AGC turned Off. In the event a BIT report shows the AGC 
as “On” use the instructions in this appendix to reset it to “Off”. 

The following sections are included in this appendix:
• Setting the AGC to “Off”

C.1 SETTING THE AGC TO “OFF”
Write a WACOL CustomCmd statement to execute the procedure.

1. From the View menu, select WACOL Shell. The WACOL Shell dialog box 
appears.

FIGURE C.1 Blank WACOL Shell dialog box

2. In the Command Line box type the following:

 prim “customcmd”, addr(1,0,1), 172, 5, “OF A5 05 50 5A”

• Where 172 is the opcode for AGC control and 5 is the number of 
command arguments in the quoted string.

• Where OF (letter “O”) turns the AGC Off and the remaining parameters 
are a required constant for the AGC command.

THIS PROCEDURE SHOULD ONLY BE PERFORMED BY A TRAINED 
COOPER NOTIFICATION FIELD ENGINEER.
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3. Click Go!. The Network Configuration Tool executes the WACOL statement. The 
WACOL statement appears in the command list box and is added to the command 
list.

FIGURE C.2 WACOL Shell command AGC Off

4. Click Close.
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APPENDIX D

Troubleshooting
This appendix includes a list of problems that may arise when using WAVES and possible 
solutions.

The following sections are included in this appendix:
• Resolving System Problems

D.1 RESOLVING SYSTEM PROBLEMS
The following table provides a list of possible problems that may occur when operating 
WAVES and resolutions for the problems. Contact Cooper Notification/MadahCom 
Customer Support if a problem persists or is not discussed in this manual.

TABLE D.1   Troubleshooting System Problems

Problem Resolution

The “Select Com Port” dialog box popped up 
when you ran WAVES for the first time.

The dialog box is telling you what COM ports 
are available for use. 

• Change the COM port or click 
Cancel to close the dialog box.

The Network Configuration Tool may already 
be running.

• Click Cancel.

A hardware failure if the selected COM port 
may have occurred.

• Check devices for failure 
notifications.

The audio from a TRX speaker is unclear. Check the reception quality of the TRX in the 
BIT Result. If the RSSI value is below 160, 
assign a different primary and secondary RF 
source to the TRX. (In a WAVES system, a 
minimum of 160-179 is required to meet the 
“Acceptable” level for signal strength and 
greater than 180 is “Good”.)

Check the Audio Mode setting.
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.

A unit’s icon changes to the blue battery icon 
on the site tree.

Indicates that the AC power supply to the 
TRX has been interrupted and that the TRX is 
now receiving power from its backup battery.

A unit’s icon changes to the red battery icon 
on the site tree.

Indicates that the backup battery power supply 
is low (has 10V or less).

A unit’s icon changes to the blue battery with 
an “X” across it on the site tree.

Indicates that the TRX does not have a backup 
battery even though it is registered as having 
one.

TABLE D.1   Troubleshooting System Problems

Problem Resolution
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Glossary 
A

ACU Autonomous Control Unit. A UFC-compliant device that is the core component of 
an individual building system. It incorporates an Audio Command Center capable 
of dispatching several prerecorded messages as well as live voice messages 
throughout the protected building.

ADU-301 Audio Data Unit. The ADU-301 is the interface between the Command Unit 
Computer and the base station transceiver, providing an interface between its 
input audio and data channels and the base station transceiver. It converts serial 
data from the Command Unit Computer to a form usable to the transceiver. It also 
provides an interface between the PC and base station transceiver.

All Call Mode Sends a live message to all unit devices in the installation site even when the 
computer is turned off.

Alternate Base Station Used if the WAVES primary base station becomes unserviceable or inaccessible.

AreaAlert The AreaAlert function is designed to identify and alert units based on their 
location, not their function. When a threatened area is identified, a list is 
constructed of units that lie in that area. WAVES determines which of its 
transceiver units is/are contained within the defined area and uses that list as the 
selected units when executing the specified script.

AVM Audio Visual Message. A Network Configuration Tool dialog box used to manage 
rdd drivers.

B

BCRLU Backup CRLU. Acts as an SRLU until a specific discrete signal is detected, at 
which time it takes over the CRLU functions for the entire network.

BIT Built-In-Test. Network-wide supervisory diagnostic report.

C

CAP Common Alerting Protocol. CAP messaging is a worldwide used XML-based 
data format that allows individuals to exchange public warnings and emergency 
alerts between alerting systems. CAP integration with WAVES allows a sending 
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agency to issue a standardized message to the WAVES system, triggering a 
configured CAP Event that executes a WACOL script.

CBRN Chemical, Biological, Radiological and Nuclear. Detection system that sends 
status and alarm messages to the WAVES Operator console.

COTS Commercial Off The Shelf.

CRLU-201 Central Relay Unit. A fully integrated transceiver located at a base station. The 
CRLU-201 transmits multiple channels of audio and visual display messages, and 
RS-232 data and control information, and receives RS-232 data and BIT reports 
for subsequent transmission to the IBS software.

D

DCE Data Communication Equipment. A device that communicates with data terminal 
equipment in RS-232 communications. For example, a modem.

DTE Data Terminal Equipment. A device that controls data flowing to or from a 
computer.

DTMF Dual Tone Multi Frequency. The WAVES DTMF utilizes a Dialogic® interface 
card to access the WAVES system remotely by any touch-tone phone. The user 
responds to pre-defined prompts in a manner similar to a voice-mail system to 
record a message to play or select a WAVES script to execute.

F

FHSS Frequency Hopping Spread Spectrum. WAVES CRLU and TRX transceivers use 
FHSS technology to broadcast RF signals over a wide range of frequencies. 
Frequency offsets are used to spread the RF signals. Receiving stations use their 
frequency offset settings to recognize and retrieve RF signals directed to them. 

H

HPSA High-Powered Speaker Array. A high-powered public address and siren system 
used in the WAVES network to broadcast live or prerecorded messages. The 
HPSA employs TRX or VHF/UHF radio transceivers for communicating within 
the WAVES system and supports both planar and horn arrays.

I

IBS Integrated Base Station. The IBS is the command center of the WAVES network. 
All sensor appliances, like panic buttons and NBC detectors send their signals 
through the RF network to the IBS, which is running WAVES software. WAVES 
software is set up during installation to either immediately respond and alert 
personnel to safety through notification appliances, such as speakers, strobes, and 
LED text signs, or to allow the operator at the IBS to decide what appropriate 
action to take.

IDS Intrusion Detection System. Sends detection status messages to WAVES.

L

LMD Local Message Device. In a WAVES network the LMD enables simultaneous 
activation of different messages at different nodes, allowing each transceiver or 
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speaker tower at a site to play different messages simultaneously, while retaining 
the common-message alerting that WAVES already performs. Local and WAVES 
Base Station audio messages are managed in a selectable prioritization.

M

MNS Mass Notification System.

MSA Mobile Speaker Array. An HPSA system housed on a sturdy trailer base with an 
extendable horn mast, locking outriggers and jockey wheel, and multiple power 
sources. The MSA is used in the WAVES network to broadcast live or prerecorded 
messages, employing TRX or VHF/UHF radio transceivers to communicate 
within the WAVES system. 

N

NAB Network Access Bridge. Acting as a bridge between a WAVES Base Station and a 
satellite WAVES system, a NAB consists of headless PC (without monitor, 
keyboard, or mouse) running NAB software, a COTS VHF radio controller and/or 
an ADU-301 and CRLU-201, a power supply, and the case that houses all of these 
components. The NAB is Ethernet-based, extending the range of WAVES 
communication to nodes distributed over a wide area and limitless distance.

NBC Nuclear Biological Chemical. Detection system that sends status and alarm 
messages to the WAVES Operator console.

Normal Mode Sends a live message to only those devices selected from the WAVES Selection 
panel.

Notification Appliance Any appliance that alerts or protects personnel.

P

PAS Personnel Alerting System.

PDB Power Distribution Board.

Peripheral Device Any appliance that provides input or sends a message into the WAVES system.

POB Power-on BIT. Tests the hardware configuration during the power-on process.

POI Point-of-Impact.

PRLU Primary Relay Unit. A field transceiver, TRX-401, addressable node configured 
as a PRLU in the wireless network that receives and broadcasts messages 
addressed to it. A PRLU can also retransmit messages it receives from a CRLU or 
another relay node, extending the range between the CRLU and an RLX.

PTT Push-to-Talk. Broadcasts a live message that is being spoken into a microphone.

R

Radio-400 An addressable VHF transmitter node in the WAVES wireless network that 
receives and broadcasts messages addressed to it on a single frequency, narrow 
band. Commands sent from a WAVES IBS are received by the radio and played to 
attached end-of-line devices. The radio also transmits messages and status reports 
upstream to the IBS. Frequency settings are preprogrammed per customer 
specifications and within the VHF range of 30 - 300 megahertz.
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Radio-500 An addressable UHF transmitter node in the WAVES wireless network that 
receives and broadcasts messages addressed to it on a single frequency, narrow 
band. Commands sent from a WAVES IBS are received by the radio and played to 
attached end-of-line devices. The radio also transmits messages and status reports 
upstream to the IBS. Frequency settings are preprogrammed per customer 
specifications and within the UHF range of 300 - 3000 megahertz.

RF Radio Frequency. A radio frequency signal sent and received through the WAVES 
network.

RLX Field Receiver End Unit. An addressable TRX field transceiver node configured 
as an RLX in the wireless network that receives and passes broadcast messages to 
devices connected to it. 

Roam Secure Cooper Notification's Roam Secure Alert Network works together with Roam 
Secure Information Exchange (RSIX) as an anywhere, anytime information 
sharing and emergency alerting system, delivering real-time critical emergency 
communication to any text-enabled device, phone, or fax on national, regional, 
and local levels. RSAN uses the Common Alerting Protocol as its messaging 
format.

RSAN Roam Secure Alert Network.

RSIX Roam Secure Information Exchange. RSIX works behind the scenes in the RSAN 
system to automatically aggregate and deliver information and alerts in real-time 
on national, regional, and local levels.

RSSI Received Signal Strength Indicator. A measurement of strength (not necessarily 
the quality) of the received signal in a wireless environment.

S

SectorAlert SectorAlert allows the grouping of units into a geographic set (sector) that enables 
all units in the sector to always be alerted together. The sectors are visually 
identified on the site map by drawing a square, rectangle, or polygon SectorAlert 
grid around a group of units by using longitude and latitude coordinates. In 
SectorAlert mode, when an AreaAlert message is received, the Threat Area is not 
compared with the unit locations but with the sector location. If any part of the 
Threat Area lies within a sector, all units in that sector are alerted.

SPL Sound Pressure Level. The physical intensity of the alarm sound.

SPT Speaker Tower. A high-powered public address and siren system used in the 
WAVES network to broadcast live or prerecorded messages.

SRLU Satellite Relay Unit. An addressable TRX field transceiver node configured as a 
SRLU in the wireless network that receives and broadcasts messages addressed to 
devices attached to it. An SRLU can also accept audio and voice input from a 
locally-connected base station and transmit it as messages from the CRLU, but 
only to units defined to be in its downline tree.

Stored Messages An optional local messaging feature that is inherently part of a high-powered 
speaker array unit’s device controller board. Stored message capability enables 
simultaneous activation of different messages at different nodes, allowing each 
transceiver or HPSA at a site to play different messages simultaneously, while 
retaining the common-message alerting that WAVES already performs.   
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T

TACWAVES Tactical Wireless Audio Visual Emergency System. A fully functional standalone 
portable alerting system capable of being rapidly deployed in the field for disaster 
relief, humanitarian missions, tent city operations, and temporary events to 
broadcast emergency announcements in wide areas.

TRX-401 The TRX-401 is an addressable transceiver node in the wireless network that 
receives and broadcasts messages addressed to it. It is addressable as a PRLU or 
RLX. Each transceiver is assigned a unique address. The TRX is a fully integrated 
unit with an integral power supply, audio amplifiers, and dual diversity antennas, 
and supports connections to optional external antennas. 

U

UHF Ultra High Frequency. A band of radio frequencies from 300-3000 megahertz.

UPS Uninterruptible Power Supply. A device used to maintain a continuous power 
supply in the event of primary power interruption.

UWI Universal WAVES Interface. An accessory to the TRX designed specifically to 
provide a simple way to interface the WAVES system to third party systems.

V

VHF Very High Frequency. A band of radio frequencies between 30-300 megahertz.

W

WA Wireless Activator. The Wireless Activator System consists of an EMP-221-WRX 
Receiver (WRX Receiver) which communicates with up to twenty-three (23) 
EMP-221-WTX Activators (WTX Activators). Together, they trigger and report 
alarm and emergency events to WAVES system.

WACOL WAVES Command Language. Script commands used to execute WAVES 
procedures.

WAVES Wireless Audio Visual Emergency System. WAVES is a secure wireless 
technology that prevents jamming, interference, and eavesdropping and protects 
the network in the event of a disaster, allowing messages to continue broadcasting 
without interruption. Existing security systems, such as fire alarms, intrusion 
detection, and CBRN detection systems can integrate with WAVES.
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INDEX
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ACU, 66
activate message, 68
configure, 66
monitor status, 68
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unit, 29
zone, 29

Addressing
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ADU-301, 4, 7
AC, 7
audio sources, 7
data port, 7
headphone, 7
microphone, 7
PC sound card, 7
power, 7
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RS-232, 7
voice output priority, 8

AGC
BIT report, 46
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Alternate Base Station, 6
Assign

Unit ID, 49
Audio

ADU-301, 7
change for unit, 39
CRC fail BIT report, 46
CRC failures, 37
mode, 36
output level, 37
site, 39
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sub-zone, 39
TRX settings, 39
volume settings, 39
zone, 39

Auto Mode, 53

Auto-Activate Digital I/O De-
vice, 69
Autonomous Control Unit, 66

B

Backup Database, 32
Base Station, 4

transceivers, 4
Battery

BIT results, 46
status, 46

Battery Level, 37
BIT, 4

condition icon, 43
parameters, 43
report parameters, 36
report rate, 44
report rate for TRX, 44
report rate for VHF/UHF 

radio, 44
results descriptions, 46
TRX settings, 44
types, 43
update results, 45
VHF/UHF settings, 44
view results, 46

BIT report, 46
Built-in Test, 4, 43
Buttons

wireless activator, 61
BWD ID, 37
BWD RSSI, 37

C

Caution Notes, iii
CBRN, 2
Central Command Unit, 8
Central Relay Unit. See also
CRLU
Change

site audio, 39
sub-zone audio, 39
unit audio properties, 39
zone audio, 39

Channel, 51
levels, 7, 39

Chemical Sensors
configure, 64

Close
monitor unit dialog box, 55
Network Configuration 

Tool, 15
Commands Menu, 18
ComPort, 79
Conventions, xvi

icons, xvii
terms, xvi

Copy
site tree to new file, 32
unit, 31

CRC, 37
BIT report, 46

Create
database, 26

CRLU
AC, 5
ADU-301, 7
alternate base station, 6
backup configuration, 6
base station transceiver, 4
DC, 5
SRLU, 5

Customer Support, xviii

D

Data Port, 7
Database

backup file, 32
creating, 26
integrity, 54
name bar, 16
printout, 55
save, 32
upgrade file, 33
verify TRX, 55

Define
site tree elements, 27

Delete
site, 30
sub-zone, 30
unit, 30
zone, 30

Detection Devices
configure, 64
configure TRX, 64
GID-3, 64
RAE, 64
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Smiths, 64
Digital

auto-activate I/O 2, 69
configure pins, 40
input, 42
monitor, 42
output, 42

Display Signs
configure, 59

E

Edit Menu, 17
Email, xviii
Emergency Priority, 41, 70

F

Families
defining, 62

Features, 2
FHSS, 82
Field Units, 2
File Menu, 17
Firmware

update, 57
update in on-line mode, 75
update in wired mode, 73
update in wireless mode, 75

Frequencies, 2

G

Getting Help, xviii
GID-3, 2
Global Site

audio mode, 36
audio options, 35
BIT report parameters, 36
definition, xvii
properties, 35

H

Headphone, 7
HPSA

BIT report, 47

I

I/O Settings, 39

IBS, 4
Icons

caution, xvii
important, xvii
note, xvii
site tree, 43

Ineligible Sources, 51
Integrated Base Station, 4
Internal Parameters Dialog Box,
51

L

LMD
Local Messaging. See also LMD
Lock Mode, 49, 51, 53

M

Menu
Commands, 18
Edit, 17
File, 17
View, 18
Windows, 19

Menu Bar, 16
Message Priority, 41
Microphone

ADU-301, 7
Miscorrelations, 37
Missed Correlations

BIT report, 46
Mobile Speaker Tower, 2
Mode

audio, 36
auto, 53
changing, 25
lock, 51
normal, 52
Off-line, 24
On-line, 24
password, 25
permissions, 24
Sw, 51
User, 24
Wired, 24

Modification Record, v
Monitor

ACU status, 68
dialog box, 42

digital, 42
refresh monitor unit dialog 

box, 55
wireless activators, 64

Monitor BIT Dialog Box, 36
Monitor Unit Dialog Box, 54
Move

sub-zone, 31
unit, 31

MSA, 2
MSPT, 2

N

NBC, 64
configure, 64

NBC Detector, 2
Normal Mode, 52

O

Off-line Mode, 24
On-line Mode, 24
Output Level, 46

P

Password, 25
PC, 2, 8
Peep, 54

monitor unit dialog box, 54
Peripheral Devices

detector devices, 9
intrusion detection system 

(IDS), 9
microphone, 9
set up ACU, 66
set up detectors, 64
set up NBC, 64
set up SPT, 60
set up wireless activator, 61
wireless activators, 9

Permissions, 24
Personal Computer (PC), 8
Pins

configure digital, 40
POB, 43

update results, 45
view results, 46

Power-on BIT, 43
Print
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database text file, 55
Priority

ADU-301 voice output, 8
emergency, 41, 70
for messages, 41

PTT, 5, 7
switch, ADU-301, 7

Q

Quality State, 37

R

Radio Frequency. See also RF
Radio-400

base transceiver, 6
field transceiver, 9

Radio-400. See also VHF/UHF
Radio-500

base transceiver, 6
field transceiver, 9

Radio-500. See also VHF/UHF
Reboot TRX, 48
Refresh

monitor data, 55
Relay

SRLU, 5
Rename Elements, 29
Report Rate, 44
RF

network, 3
RF AGC, 37

BIT report, 46
set to off, 77

RF Network, 51
RF Settings, 51
RS-232, 4

ACU, 66
ADU-301, 7
chemical sensors, 64
detection devices, 64
port, 49
sirens, 60
to RS-422 conversion, 7
visual displays, 39
wireless activators, 61

RS-422, 7
RSSI, 37

BIT report, 46

S

Safety
cautions, iii
general notices, iii
summary, iii
warnings, iii

Save
database files, 32

Sirens
configure, 60

Site
change audio, 39
delete, 30

Site Tree, 16
add sub-zone, 29
add unit, 29
add zone, 29
copy, 32
creating new database, 26
define elements, 27
details, 23
navigation, 22
organization, 21
rename elements, 29
reorganize, 30

Sound Card, 7
Source

BIT report, 46
Speaker Tower, 37

BIT report, 46
SRLU, 5, 51

alternate base station, 6
Strobe

auto-activate, 69
Sub-Zone, 22

add, 29
change audio, 39
delete, 30
move, 31

Sw Mode, 51

T

TACWAVES, 2
Telephone, xviii
Theater, xvii, 22
Toolbar, 16
Transceiver, xvii

base station, 4

CRLU-201, 4
field, 8
Radio-400 (Base), 6
Radio-400 (Field), 9
Radio-500 (Base), 6
Radio-500 (Field), 9
TRX-401, 8

Transmit Offset, 71
Troubleshooting, 79
TRX, xvii

ADU-301, 7
assign Unit ID, 49
audio settings, 39
auto mode, 53
configure ACU, 66
configure chemical sensors, 

64
configure detection devices, 

64
configure display sign, 59
configure pins, 40
configure sirens, 60
configure wireless 

activators, 61
configure wireless receiver, 

63
detection devices, 64
field transceiver, 8
internal parameters, 52, 53
lock mode, 49, 51, 53
normal mode, 52
reboot, 48
update, 31
update firmware, 57, 73, 75
verify internal database, 55

TX Offset, 51
numbers, 72
using offset numbers, 71

U

UFC, 3
Unit, xvii, 22

add, 29
address, 51
addressing, 27
change audio, 39
copy, 31
delete, 30
move, 31
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peep, 54
type, 51

Unit Details
BIT report, 37
panel, 16

Unit ID, 49, 51
assign, 49

Update
BIT results, 45
POB results, 45
TRX, 31
TRX firmware, 57

Upgrade
database file, 33

UPS-901, 5
User Mode, 24

V

Verify Database, 55
Version Update Dialog Box, 74
VHF/UHF

base transceiver, 6
BIT settings, 44
field transceiver, 9
report rate, 44

View
BIT results, 46
POB results, 46

View Menu, 18
Voice

channels, 5
volume settings, 39

Volume
audio setting, 39
voice setting, 39

W

Warning Notes, iii
WAVES

central command unit, 8
description, 1
features, 2
methodology, 3
PC, 2
system components, 3

Windows Menu, 19
Wired Mode, 24
Wireless Activators

alarm event, 61
configure, 61
configuring for TRX, 63
events, 64, 65
families, 62
monitor, 64
red button, 61
white button, 61

Z

Zone, 22
add, 29
change audio, 39
delete, 30
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